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6.1 OpenOffice.org Impress: Using the Application

6.1.1 First Steps with Presentations

6.1.1.1 Open (and close) a presentation application

Open Impress under Windows Open Impress under Linux
« Click Start. - Click Start Applications.
« Click Programs. + Click Office.

+ Click OpenOffice.org + Click Presentations.

« Click Presentation

Click OfficeOffice.org Impress

Depending on how the package was installed, Impress may display a blank slide or it may
launch Autopilot which will take you through a number of dialogues shown below.

P4 AutoPilot Presentation

=10l x|

" From template

g Open existing presentation

¥ Preview

[ Do notshow this dialog again

Help Cancel | o Back | Mext > I Create |

You may now make use of autopilot to guide
you through the creation of a presentation or e
you may create the slide show manually. [sice 1

Select an Autolayout

QK

Cancel

Help

il

Create a slide show manually

* Click Create.

+ Select an AutolLayout for a slide or None ool | |EEEE
by clicking the first option.
* Give the slide a Name. = = = B =
. Click OK. @=] [=dn) = aln = -
Title Slide
A blank slide will be displayed. Blapiy

¥ Background

¥ Objects on background
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6.1 OpenOffice.org Impress: Using the Application

Menu bar
Main toolbar

Function bar

Ruler

Object bar

Work area

E Un .edl - Open(iffice.org 1.1.0

File Edit ¥iew fnsert Format Tools SlideShow Window Help

[ 7/ ﬂ|@w||@.|x@|p~;s|+_.¢§~-&| //
EX|

r|[oonem [ EMBack x| & coor  x|[E e = E?\ /
1@ 17 18 19 zo |21 22

s
S 3 24 25 26 27 2 29 3

1 2 3 4 5 6 7 8 &8 1011 12 13 14 15

Click to add title

9

Click to add text

Y€ hme|LfleRQBE
7

- 1% 12 11 10

Convention

Because we will be making extensive use of the Menu bar, we will make use of the
following convention in using the functions of the menu bar.

* File >> Close.

Will mean exactly the same as

* Click File on the Menu bar.
* Click the Close option in the menu.

Close a presentation

* File >> Close.

This will close only the active presentation. If it has not yet been saved, Impress will warn you
and ask you if you wish to save it.
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6.1 OpenOffice.org Impress: Using the Application

Close Impress

+ File >> Exit.

This command will close all open presentations and exit Impress. If any of the presentations
have not been saved to disk, Impress will ask you if you wish to save them before exiting.
6.1.1.2 Open one, several presentations

* File >> Open.

At this stage there is a difference between what will happen in Linux and Windows.

Linux:
The Open dialogue will appear. In general, this
will point to your home directory. fomasi o] et =]
; . . .. LS [Type [size [Date modified

In this case, the Open dialogue is pointing to  [Ee=e— o o aesies
the directory /home/david' = tmp Folder 20/01/2004, 15:00:14
« If necessary, navigate to the desired

directory.
+ Set the File type to Presentations. e \ gl
» Highlight the presentation you wish to open. persen ! e |
. CIICk open. File type: [Presentations | i

[ Read-only

If you wish to open a file contained on your floppy, navigate to the directory /mnt/floppy.

On the top right of the Open dialogue, there are three important icons:

Up one level: Pressing this icon will move you to the parent of the current directory.

Create new directory: This option allows you to create a new directory in the current
directory. In order to be able to do so, you will need the appropriate user rights.
Default directory: Pressing this icon will move you to the default directory. This is
useful if you have moved through several directories and wish to return to your
starting point in the directory tree. This will be different for each user.

BB %
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6.1 OpenOffice.org Impress: Using the Application

Windows:
If you are running Impress under open 21X
Windows, the Windows Open dialogue 1 DperBouceBook - e EckEr
will be displayed. = ag:g:gp
If you click in the Look in window, a recen ||
drop down box will display your € -l
current directory and available drives. e $ :
You can switch to another drive by “m ;
double clicking on it in this window. o
You can also use the navigation icons UM | 5 oy onwis? 2)
to move around your directory o Sl
structure. il
My Computer:
« If necessary, navigate to the e
desired directory. R,
« Highlight the presentation you wish " fere | s [ |
to open. Files of type: IPlesentalions j Lancel

* Click Open. Herson | i |

I~ Eead-only >
If you wish to open a file on your
floppy disk, first double click on
Floppy A: in the Look in window.
The first two icons in the Open dialogue are the same as under - ;
Linux. o B~

Thumbnails
The third icon allows you to display the contents of the Open Tiles
dialogue in a number of ways as shown on the adjacent screen. Icons
List

The Details option displays important information such as file type, . Beta”s

size, created or last edited and attributes.

Open multiple presentations

You may open several presentations at the same time. Simply repeat the process described
above.

Although the files will all be open, only one will be displayed on your screen for editing. We will
refer to this as the active document.

Open a slide show from within Writer or Calc

Since OpenOffice.org is a highly integrated application suite, you may open a presentation
from within either Writer or Calc. OpenOffice.org will then automatically open Impress.

* File >> Open.
« Select All files (*.*) or OpenOffice.org Presentations under Files of type.
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6.1 OpenOffice.org Impress: Using the Application

Filz name: I j Open I
Files of twpe: I,-‘.‘-.II file= [*.%) _ﬂ Carncel |
"Wersion: I j

I~ Bead-only >
i

This will display all files saved in the current directory. Depending on the type of file you
select, OpenOffice.org will automatically open the correct program in the application suite.
6.1.1.3 Create a new presentation (default template)

The process of creating a new presentation is the same whether Impress, Calc or Writer is
displayed on the screen.

* File >> New >> Presentation.

This will initiate the process described in 6.1.1.1. That section described how to create a
presentation manually.

Create a presentation using Autopilot

Autopilot is similar to a wizard in Windows. It guides you through the process of
accomplishing a task.

The following is meant as a brief outline of

the process. The details will be described ,}

in Chapter 2. .
Type

" Empty presentation

+ Select From template.

& From template|

" Open existing presentation
You could at this point open an existing |
presentation or select Empty
presentation if you do not wish to use a

template. ¥ Preview
™ Do not show this dialog again
+ Click Next. Help Cancel - [ text== Create
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6.1 OpenOffice.org Impress: Using the Application

Select an output medium [§ autopilot Presentation

* Select Screen if you wish to view the
presentation on a computer.
* Click Next.

<Original>

Select an output medium
 Original ¥ Screen

 Qverhead sheet " Slide

V¥ Preview
 Paper

Help Cancel | << Back i Next == I Create

Select a transition [§ Autcpilot Presentation

A transition refers to the method of fading
one slide out and the next one in.

Select a slide transition
Effect From Top Leffid

Speed Medium -
- Select an Effect. ‘
Select the presentation type

- Select a Speed. & Default

+ Click Next. © Automatic
Duration of page m
Dugation o 5¢ (o000 | = Preview

Help | Cancel | << Back i Next == I Create |

Fade

Enter slide data

» Enter details of the presentation. q = : @*"

. Describe your basic ideas
.
CI ICk NeXt' What is your name or the name of your company?

What is the subject of your presentation?

Further ideas to be presented?

Help Cancel << Back i Rt == Create

* Click Create. [ autopilot Presentation

Chgose your pages

[ HE

¥ Preview

[~ Create summary

Help Cancel << Back Next ==
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6.1 OpenOffice.org Impress: Using the Application

Select the type of the first slide Modify Slide
Name
-
« Impress names the first slide Slide 1. pide L —
You may enter a different Name, if you  >efectanAutolayout | e
wish. — — Help
+ Select an AutoLayout or None for a e = ==
completely blank slide.
+ Click OK. al| |EEE
You would now create your first slide. e = i =
When you have finished, you would insert &= = ll =g |lh= 5
a new slides. Title Slide
Display
- Insert >> Slide. I/ Hatkqrodnt
W Objects on background

6.1.1.4 Save a presentation to a location on a drive

When you work with a presentation on your computer, the working form resides in the
computer's RAM. This is temporary memory used for your current activities. Since RAM is
volatile, when the computer is switched off, everything that is in RAM is automatically lost. In
order to keep your work you will need to transfer the contents of RAM to your hard disk. This
process is called saving.

When you save a presentation, you give it a name and you specify where it is to be stored.

Save an existing presentation

If you have opened a presentation and made some changes, the process of saving it is very
simple:

* File >> Save.

This will change the contents of the stored version so that it is identical to the version that is
displayed on your screen. In this case, the previous version on disk is overwritten.

If you use File >> Save in a newly created presentation, Impress will automatically assume
that you wish to use File >> Save as.

Save a new presentation

When you create a presentation from scratch, there is no version stored on disk. To save the
file to disk:

* File >> Save as.

Now depending on whether you are using Linux or Windows, slightly different dialogue
windows will be displayed.
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6.1 OpenOffice.org Impress:

Using the Application

Linux:

The Save as dialogue will appear. In general,
this will point to your home directory. It is very

similar in appearance and functionality to
Open dialogue.

which you wish to save the file.

Click Save.

Impress will add the .sxi extension to the file.

Windows:

The Save as dialogue window has a very
similar structure to the Open window.

If you click the Save in window, your
position within your drive and directory
structure will be displayed.

If necessary, navigate to the directory in
which you wish to save the file.

Enter a name into the File name
window.

Click Save.

For the moment we will not be concerned
with all the options in the Save as
dialogue.

If necessary, navigate to the directory in

Enter a name into the File name window.

Save as (O] x]
/home/david/Documents cf | &
the Title [Type [size [Date modified
File name: [MyFirstPresentation | Save
File type: ‘Openofﬁce.nrg 1.0 Presentation (.sxi) L] Cancel
Help
I~ Save with password W Automatic file name extension
Savens 2(x|
Savein | OpenSouceBook =] « = E-
) Recent
@__Desktop
(L My Documents
§ My Computer
3% Floppy [4:)
== Local Disk [C:)
L ICDL (D)
“e= IMAGE |
[ ¥0pen
=e= Data [F:
;s Clipart on Wws2' [v:]
= dorcthy on s (2]
W My Network Places
5 () Administrative Tools
My Computer
.
M?F". S| Fils name [Jupiter k3| save |
| ac
Save as ype |Openiifice.org 1.0 Presentation [ sxi) =l Caneel

¥ Autamatic file name extension

™ Save with password

6.1.1.5 Save a presentation under another name

When you use the File >> Save function, the contents on disk are overwritten by the contents
on your screen. It often happens that we do not want to do so. In other words, we might wish
to keep copies of different versions of the file under different names.

Another possibility is that we wish to keep copies of the same presentation, but in different

places.

In both cases use the File >> Save as function.

Suppose, for example, you are creating a presentation and are not sure of which version you
are going to use. Suppose you initially call the presentation Gimmick Sales. After having
made some changes you could use Save as, but this time call the document Gimmick Sales1.
The following version could be Gimmick Sales2, and so on.
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6.1 OpenOffice.org Impress: Using the Application

6.1.1.6 Save a presentation in another file type such as: Rich Text Format,
template, image file format, software specific file extension, version
number

File formats

There are many different presentation packages. One of the very important aspects of working
with information technology is the ability to exchange documents between different systems.

Each application has its own way of storing information in electronic form. This is known as the
format of the application. For example, Microsoft PowerPoint stores documents in a different
electronic format to OpenOffice.org Impress.

Another issue we need to contend with is that as software develops in sophistication, the
format of the documents will change to cater for the increased sophistication. We also need to
be able to store a document in a format that could be read by an earlier version of an
application package.

There are also a humber of generic formats that can be used. These are formats that are not
specific to a particular application but which have been designed by the information technology
industry to form a common basis for all documents.

Each format has its own file extension. Sometimes we refer to the format by its extension. For
example, Impress creates .sxi files while Microsoft PowerPoint creates .ppt and .pps files. Rich
text format, a generic format, uses the .rtf extension.

Web browsers can only read documents created in Hypertext Markup Language or .html.

Apart from its own format, Impress allows you to store documents in a wide range of formats.

To save a file in a particular format (the method is the same in both Linux and
Windows):

File >> Save as. File pame: ‘Andromeda j Save |
 Click on the Save as type drop down Fflesre Cancel
. OpenOffice.org 1.0 Presentat!on (.sxi) ) ;]
window, e |
. Select the type_ ™ Save with passw?{:S?afhf;c;.é)Egg;fﬂg!%?:lgrtﬁ&?rgicig;Iga‘)\lmpress) (.sxd)

* Click Save.

Notice that the Save as type window lists both
formats and versions of formats.

The following table provides a reference to some common file types.
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6.1 OpenOffice.org Impress: Using the Application

Format Extension Details
Impress SXi This is the natural format in which Writer saves its
documents
MS PowerPoint ppt & pps | Writer enables you to save documents in the formats of the
different versions of MS Word
Impress Template sti This is a format designed for the creation of a template on
which to base other presentations.
PowerPoint pot The microsoft version of the above.
Template

Save a presentation as HTML

Documents that are meant to be read by web browsers such as Internet Explorer and Netscape
must be saved in HTML format. This is an abbreviation for HyperText Markup Language. To
save as html,

« Click on File >> Export.

« Select the directory in which you wish to save the file.
+ Enter a file name.

- Click Save.

Save a file in pdf format

Portable Document Format -this is a particularly important format. If you create a file in pdf
format, you can send this to other users who can view it with the free Adobe Acrobat Reader.
They are, however, unable to edit it.

« File >> Export as PDF.

« Select the directory in which you wish to save the file.
« Enter a file name.

« Click Save.

If you wish to send an Impress presentation to someone who only has Microsoft Office, you can
save the presentation in PowerPoint format.

Save az type: icrosoft PowerPoint 97 /2000 =P [.ppt..pps]

6.1.1.7 Switch between open presentations

Suppose you have a presentation open on your screen. If you open a second presentation,
Impress will move the first presentation to the background without actually closing it. You may
repeat the process and open a third presentation. The presentation displayed on your screen is
the active one. It is on this one that you may do your editing. You may bring any presentation
to the foreground for editing as explained below.
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6.1 OpenOffice.org Impress: Using the Application

* Click Window.

* Click the presentation you wish to switch to.

entation.sx - OpenOfice.org 1.1.0

[imntjwin_d/OpenSourceBook/impressPresenti »] &
= o= ~|[0:00cm =] W Black
E‘ra 3 2 i 1 2 3 4 5 6
&

-

Insert Format Tools Slide Show [FNREIN Help

New Window
Close Window

impress.sxw - OpenOffice.org 1.1.0
Writer.sxw - OpenOffice.org 1.1.0
Andromeda.sxi - Openoffice.org 1.1.0

Jupiter.sxi - OpenOffice.org L1.0

Control+W

25| + ImpressPresentation.sxi - OpenOffice.org 110

You may have a mixture of application types

open at a time. For example, you might have
documents, spreadsheets and presentations
all open. As you switch between windows

containing th

6.1.1.8 Use available Help functions.

e different types of files,

OpenOffice.org will automatically activate the
appropriate application.

The help system of OpenOffice.org provides a complete reference to the system.

Contents

* Help >> Contents.

This accesses the help system of OpenOffice.org, not just Writer.

Eﬂpenﬂfﬁce.org Help - Help about OpenOffice.org Writer

|He|p about OpenCffice.arg Writer

Contents | Index | Find | Bookmarks

S Bles | EF

([ Text Documents

@ Command and Menu Reference
Q@ Creating Text Documents
25 i
{ZE] Using the Direct Cursor
@ Graphics in Text Documents
@ Tables in Text Documents
@ Dbjects in Text Documents

& Tables of Content and Indexes
@ Fields in Text Documents

@ Mavigating Text Documents
@ Calculating in Text Docurments
@ Forrmatting Text Documents
@ Special Text Elerments

@ Automatic Functions

& Numbering and Lists

@ Troubleshooting Tips

@ Master Documents
@ Links and References
@ Printing
@ Searching and Replacing
@ HTML Documents
@ Farmulas
@ Presentations and Drawings
@ Charts and Diagrams
@ Soreadsheets

@ Ceneral Information and User Interface Usage

@ Sections and Frames in Text Documents

@ Spellchecking, Thesaurus, and Languages

@ Loading, Saving, Importing, and Exporting

* Click on the Contents tab.

Each book represents a major section.

Navigating and Selecting With the Keyboard

You can navigate through a document and make selections with the kevboard.

Key Function +Ctrl key

Right/left [Moves the cursor one  |Moves the cursor one word to the left or to the right.

arrow character to the left or

keys to the right.

Up/down |Moves the cursor up or |(Ctrl+alt) Moves the current paragraph up or down,

arrow down one line.

keys

Home Moves the cursor to the|Moves the cursor to the beaginning of the document.
beginning of the
current line.

Home Maoves the cursor to the|Moves the cursor to the beginning of the contents of
beaginning of the the current cell. Press again to move the cursor to the

In a table |fontents in the current |first cell in the table. Press again to move the cursor
cell. to the beginning of the document.

End Maoves the cursor to the|Moves the cursor to the end of the document
end of the current line.

End Maoves to the end of Maoves the cursor to the end of the contents of the
the contents in the current cell. Press again to move the cursor to the last

In a table |current cell, cell in the table. Press again to move the cursor to the

end of the document.
PaUp Scrolls up one page, Maves the cursor to the header.
PaCn Scroll down one page. |Moves the cursor to the footer.

Related Topics
Shortcut Keys for OpenOffice.org Writer

Fannesl Chastroak Vaue in OnanOfficn nen
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6.1 OpenOffice.org Impress: Using the Application

+ Double click on any book icon, for example Text documents. This will display the contents
which may be further subsections or actual entries.

» Double click on a subsection, for example Creating text documents.

» Double click on a entry, for example Selecting and navigating with the keyboard. The
right hand pane will contain a detailed description of the topic.

Index

The Contents tab is the same as the table of contents at the front of the book. This organises
entries by function.

The Index tab functions in the same way as the index at the back of the book. This provides
an alphabetic listing of topics.

* Click on the Index tab.
* Begin typing a term that you are interested in into the Search term window. Type for
example the word template.

OpenOffice.org will attempt to anticipate what you are searching for. As you type in the
Search term window, the alphabetic listing of topics will change. The entries are divided into
headings and actual topics. The headings are flush against the left hand side of the pane while
the actual topics are slightly indented.

» Double click on an entry.

Eﬂpenﬂfﬁce.org Help - Help about OpenOffice.org Writer & IEII

iHeIp about OpenCffice.arg Writer j | <::' * ﬂ| % @

Contents Index | Findl Bookmarks |

Creating a Document Template

Search term

rEmplates &l You can create a template to use as the basis for creating new text documents.
changing basic fonts .
changing default ternplates 1. Create a document and add the content and formatting styles that you want,
creating docurmnent templates You can also load styles from another text document by choosing Format - Styles
creating from selections - Load.
default templates h il |
deleting 2. Choose File - Templates - Save,
docurnents 3. In the New Template box, type a name for the new template.
i : o
fei);rdosr ‘ng 4, Select a template category in the Categories list,
HTML default ternplate 5. Click OK.
importing

3 To create a document based on the template, choose File - New - Templates and
loading Styles from Documents, select the template, and then click Open.
new documents from templates

opening document

organizing Related Topics

arganizing {guide) Templates and Styles

saving Changing the Default Template
searching when opening File - Templates - Save
selecting

selecting address boaok
termplates and styles (guide)

The right hand pane contains the details of the topic you have selected.

Within the details of the entry you will also see a number of hyperlinks. These are underlined
in blue. These are references to related topics. To jump to one of these entries, double click the
hyperlink.

Find
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OpenOffice.org provides yet another method of searching for information. Whereas both
Contents and Index are based on an alphabetic listing of topics, Find allows you to search
within the text of the entries for topics using a keyword.

Suppose you did not find the previous description of the term hyperlink adequate and you
wish to find all topics in OpenOffice.org that make reference to this term.

* Click on the Find tab.

» Type the work hyperlink into the Search term window.
+ Click Find.

A list of entries that contain the word hyperlink are displayed.
» Double click on the entry that you wish to read.

Eﬂpenl]fﬁce.org Help - Help about OpenOffice.org Writer i l E||‘
lHeIp about OpenCffice.org Writer j | @ = ﬁ| % @

Contents I Index Find I Bookmarks |
yperlink

Search term

| yperink [ Find |

[ Complete words anly Inserts a lgfaEldllels from the current URL into your document. The URL address is taken
- _ fram the entry in the Internet URLs combo box, and the name of the link is taken from

I” Find in headings anly the URL Name combo box.

Hyperlink Bar = You can insert the [YTTEHNG as text or as a button, Long-click the [ETTTIEMNE icon, then

Character select As text ar s button from the menu. The mqis then inserted at the current

Default cursor location,

Hyperlink Bar

Hyperlink

Description
Hyperlink

Mew Docurment

Hyperlink Dialog

Document

Internet

AutaCorrect has been activated

The occurrences of the search word are highlighted in the details window.
Print entries in Help
* Click the print icon,

Create bookmarks

When you read a book you may sometimes turn the corner of a page to mark important pages
for easy later reference. A bookmark is the electronic equivalent.

Ep

+ Click the create bookmark icon, , to mark an entry.

+ Enter a name for your entry in the Add to bookmarks dialogue.
» Click OK.

Use bookmarks

* Click on the Bookmarks tab.
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A list of bookmarks you have created will be displayed.

« Double click on an entry to read the details.
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6.1.1.9 Close a presentation

Although you can have several presentations and documents open at a time, it is not a good
idea to have unnecessary documents open as these use up system resources and can slow
your machine down. Just as important is the fact that it is just simply very confusing to have
too many documents open at once. This is similar to working with a cluttered desk and not
putting things away when you have finished with them

To close a document:
* File >> Close.
If the version in the work area corresponds to what is saved on disk, Writer will close the

document immediately. If you have edited the document since it was last saved, Impress will
check whether or not you wish to save or discard the changes before closing.

6.1.2 Adjust Settings

6.1.2.1 Use magnification/zoom tools
Full screen

If you wish to work with a presentation without having the object bar, toolbar, menu bar or
scrollbars displayed, use Full screen mode. In this mode, the document will be displayed as it
will be printed.

» Switch off the ruler using View >> Ruler. If you wish to see the ruler in full screen mode,

leave this step out.
* View >> Full screen or press Shift+Ctrl+J (Hold down both the Shift and Ctrl keys and

press J.)

To return to normal viewing:

* Press the Full screen on/off icon or press Shift+Ctrl+J.
* Switch on the ruler using View >> Ruler, if necessary.

Use zoom x
Zoomfactor ————————————————
" Entire Page

To change the zoom in Drawing mode:

= Page Width Cancel |
+ View >> Zoom. L oeenl wos |

e Set the zoom factor or select Variable and enter C 200

a % value. C 1s0%

« Click OK.

 75%

» Click Entire page to display the complete slide L
on the screen. [ yariable
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6.1.2.2 Display, hide built-in toolbars

To view or hide toolbars: Function Bar
. W DhjectBar

* View >> Toolbars. _

o hain Toalbar
This will display a list of toolbars. The toolbars that are ticked are W Hyperlink Bar
those that are currently displayed. Each of the options in the B FarrmulaBar Fz
submenu functions as a toggle.

CUstamizZe...

» To display a hidden toolbar or hide a displayed toolbar, click the appropriate item.

A toggle is a menu item or icon that reverses the current status. For example, if the
Function bar is displayed, View >> Toolbars >> Function Bar will hide it. On the
other hand, if it is hidden then the same sequence will cause it to be displayed.

6.1.2.3 Modify basic options/preferences in the application: user name,
default directory/folder to open, save presentations

When you start OpenOffice.org, it makes certain assumptions as to who is creating the
documents, where you wish to save documents, the language you wish to use. These are the
default conditions.

The basic options are set using:

+ Tools >> Options.

This will display the Options dialogue. Since OpenOffice.org is a highly integrated application,
many of the options will apply to all the programs in the suite while others are more specific.
Which type of option is found in which section is clear from their names.

User data

When Writer creates a document, it stores the name of the creator of the document. It also
stores other information along with this. To set the default user name:

Dptions - DpenOffice.org - User Data x|

B OpenOifice.org
Address

* Tools >> Options. i
« Click the + symbol next to OpenOffice.org i

- \:”e:vt First/Last name /Initials | | r_
to expand the options. ecasnairoaciie (RS |
 Click User data. o cryfsare 2 [ I
. . . . . Fonts
+ Fill in which ever options you wish. ey Countyifeaon porce
. C||Ck OK. Aftpess\h\\ltv TEleiEes o, [ |

Load Save

Langinge Seeigs el tome ey | |
Internet

Text Docurnent

HTML Document

Faz [ E-mail | |

Spreadsheet
Presentation
Drawing
Farrmula
Chart

Data Sources

=13 I Cancel Help Bark
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File locations

When you open or save a file, Writer will use the location you set in Options as a starting
point. This will be the path that will be displayed in the Open and Save as dialogues.

To set the default file locations:

* Tools >> Options.

* Click the + symbol next to OpenOffice.org to expand the options.

* Click Paths.

This will display the default paths Writer will use for a wide range of options. The following

screen shows the display when you are using Linux.

[§ options - Openoffice.org - Paths

B OpenOffice.org
User Data
|General|
Memory
View
Print
External Programs

Colors
Fonts
Security
Appearance
Accessibility
B Load/Save
|General|
VBA Properties
Microsoft Office
HTML Compatibility
Language Setfings
Internet
Text Document
HTML Document
Spreadsheet

Presentation =
j ) s : |

HEHEHEE

Default
Type [Path
Add-ins fusrflibfopencffice/programyaddin
AutoCorrect fusr/lib/openoffice/share/autocorr;fhome/davidl.openc™ |
AutoText Jusrflibjopenoffice/share/autotext/english_uk:home/dz
Backups fhome/david/.openofficejuser/backup
BASIC fusrflibfopencffice/share/basic.home/david/.openoffic
Dictionaries Jusrflibjopencffice/share/wordbock/english_uk
Filters Jusr/libjopenoffice/program/filter
Gallery fusrflibjopencffice/share/gallery./home/david/.openoff
Graphics fusr/libfopenoffice/share/gallery
Icons Jusrflibfopenoffice/share/config/symbol
My Documents fhome/david/Documents
Palettes fhome/david/.opencffice/user/config
Plug-ins fhome/david/.opencffice/user/plugin |
Templates Jusr/lib/opencffice/share/templatefenglish_uk:/home/d
Temporary files fhome/david/tmp
User Confiouratio thome/david/.onenoffice/usericonfia Jﬂ

3

The following screen shows the display under Windows.

Options - OpenOffice.org - Paths B

B CpenOffice.org
User Data
General
Mermaory
Wiew
Print
External Programs
Calors
Fonts
Securing
Appearance
Accessibilitg

Load fSawve

Language Settings

Internet

Text Document

HTML Docurment

Spreadsheet

Presentation

Drawing

Farmula

Chart

DataSources

HHEHEEHHEHEHBEH

Diefault
Type |Path
Add-ins C:A\Program Files{OpenOffice\programaddin =
AutoCarrect C:\Program Files\OpenOffice\shareautocorr, C:\Progrs:
AutoText C:\Program Files |\ OpenOffice\share jautotextienglish; C
Backups C:\Program Files | OpenOffice\user{backup
BASIC C:\Program Files|\ OpenOffice\share\basic;C:\Program |
Dictionaries C:\Program Files\ OpenOffice\share \wordbook)english
Filters C:\Program Files!| OpenOffice \program | filter
Callery C:\Program Files|\ OpenOffice\share !\ gallery;C:\Prograrr
Craphics C:\Program Files| OpenOffice\sharelgallery

lcons

My Docurnents
Palettes
Plug-ins
Termplates
Temporary files
User Configuration
4

C:\Program Files\ OpenCffice\ share\config! symbaol
C:iDocurme i S nistrator i My Docume
C:\Program Files\OpenOffice \user\config
C:\Program Files\OpenOffice\user\plugin
C:\Prograrm Files\OpenOfficesharetemplate\english;C
CADOCUME~1 \ADMIN1 \LOCALS1 \ Temp

C:\Program Files\ OpenOffice\user\config 'i

L3

LDrefault | Edit... |

o |

Cancel | Help | Back
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+ Double click My documents.

Select path I= B3
/home/david/Documents ﬁ@

Title IType ]Size ]Date modified

Path: [fhome/david/Documents/ ] Select |
Cancel
Help

« Navigate to the desired directory / folder in the usual way.
* Click Select when done.

Terminology: The terms directory and folder can be used interchangeably. Linux prefers the
term directory whereas Windows prefers the term folder.

+ Expand the Presentation option.

Options - Presentation - General i |

Opendffice.org
Load fSave
Language Settings ¥ Allow quick editing [v¥ Only text area selectable
Internet

Text Document Mew document
HTHL Docurnent [V Startwith AutoFilot
Spreadsheet

Presentation Semings

Text objects

DNHEHEHERA

W Use background cache

Wiew
Grid [~ Copywhen moving
Print
Drawing ¥ ©bjects always moveable
Forrmula 2 l ; I | AI
Unit of measurement  |Centimeter x Tab stops |1.25cm <
Chart — B
Data Sources

Start presentation

¥ Always with current page

Compatibility

[ Use printer metrics for docurnent forrmatting

[T Add spacing between paragraphs and tables {in current document)

Ok I Cancel | Help | Back |

For example, you might wish to switch off Autopilot when Impress starts. You could do this by
unchecking the Start with Autopilot option in the New Document area of the previous
dialogue.
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6.2 OpenOffice.org Impress: Developing a Presentation

6.2.1 Presentation Views

6.2.1.1 Understand the uses of different presentation view modes

Impress has a number of ways you can view the presentation.

Slide view

Slide view is the normal way of working with a slide. Depending on the zoom factor you use,
you will see the slide or part of the slide in the way it would appear if viewed as part of a slide
show on-screen.

The following two screens illustrate a presentation in slide view with different zoom factors.

- View >> Zoom >> Entire page.

@

K

r|[ooocm MM enck ¥ {ﬂcmor M EET O @

910 11 12 13 14 15 16 17 16 19 20 21 22 23 24 25 26 27 2R 29 &0 31 a2

i Integration

Impress 1s fully integrated with the other programs
- in the OpenOffice org suite

You can create a new presentation not only from

10

within Impress but also from Writer and Calc.

You can open en existing presentation from
Impress, Writer or Calc.

Hlleaty @ume|sl.iReB1 % FRrl|
li

o OpenOffice.org will automatically activate the
. Impress environment when needed.

# In Slide view, you can navigate between the slides by clicking on the appropriate slide
name next to the Horizontal scroll bar at the bottom of the screen.
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View >> Zoom >> Page width.

] g

2| b = =|loooem (MM enck - {hlcmor = R = =

,EE...].‘.2...3...4...5...6...7...8...9...m..|.”...]2...13...]4...,5...16...17...]8...]9...20...2]...22.. 23.‘.24...25...26...27...2£|:E

Ll :

B Integration

B | - -

@

: . . .

" R * Impress is fully integrated with the other programs

=l in the OpenOffice.org suite

G .

B * You can create a new presentation not only from

al: within Impress but also from Writer and Cale.

2" — .

=k * You can open en existing presentation from

& | - :

: Impress, Writer or Calc. | |
* OpenOffice.org will automatically activate the
= Impress environment when needed.
.| E
I | slele |y 1 side 1 slide 2 (Slde s /. KD | b

I [ 21061 p17.20 8e% | blide2 3 [pefaure

Master view

A slide master is a slide that contains elements that are common to all the slides in the
presentation.

You can think of the slide master as the background on which other slides are created.
In Master view you are able to create or edit the slide master.

Layers

Layers are transparent containers for objects that make up a slide.

The following description may seem a bit confusing when you read it for the first time. Treat it
as a reference that will make more sense once you become familiar with Impress.

There are three default layers in Impress:
- Layout

- Controls

- Dimension lines

The Layout layer contains the position for the title, text and various objects on a slide. When
you make use of an autolayout, you are imposing a different layout layer on the slide.
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The Control layer contains buttons that have been assigned an action. For example, if you
insert a control on a slide that will close the presentation, this will be stored in the control
layer.

These layers may not be deleted.

You can add your own layers. You could, for example, create a Text layer which contains all
the text of the slides. If you add a new layer to a slide, this will automatically be added to all
slides.

If you switch to Layer view, you are able to view the different layers of a slide.

In layer view, the different layers will be displayed next to the horizontal scroll bar at the
bottom of the screen. You can click on any of these to work with the different layers.

rE EIlF I<| A | ¥ |>I|\ Laxout( Controls 4( Cimensian Lines_/ ULI | J
Preview

In Preview mode, a reduced view of the entire current slide, as it would appear in a
presentation, is displayed on-screen. This is useful where you are working with a magnified
view of the slide and can see only part of the slide at any one time. This is illustrated on the
next screen.

T
< | @?“:‘(’I v|loooem Z[MMback x| M fcoor  r|[EEner x] O &
[ﬂ--z---3---4---5---s---7---a---9---10---11---12---13---14---15---1s-|-17---13---19---20---21---22---23---24---25---26--
(24 I Preview

__[T .

)

Full editing features

] » » * Irpress bas a full st of editing features for

' Full editing featur| e

T * Yom can copyfrora another pressntation or fiora

; docinent or finmm a spreadsheet into the cument
presentation

s * If yom koo howr to edit in Writer then you
antornatical Iy kroow howr to edit in Trapress.

| © Impress has a full set of editing fea
-|  copying, moving and formatting.

.| ® You can copy from another presentation or froma _
|  document or from a spreadsheet into the current

by (@ hme(2lanel
=

Sz

“|  presentation.
2| o If you know how to edit in Writer then you
_Iﬁ:ﬂnlmlmhlsﬁll\sﬂﬁe]‘(sndezi_s:lid_e'a‘-/II 1 IETN e _J:i:“ T N LI;I
I [+ 16487 1429 [ 100% [* Bldes i3 [pefaute

Workspace views

There are a number of Workspace views. These display the slides in a variety of different
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ways.

Workspace view: Drawing

This is the normal view for editing a single slide.

Workspace view: Slides

In this mode, the slides are displayed side by side in reduced form as shown on the following

screen. Slides view is the same as the term Slide sorter used in Microsoft Office.

rfect [0 Erfect 7| [wedium =] Transition [manual =] | = @| @ [asices 3]
ct
=
OpenOffice.org Integration Full editing features

Impress

The fatures of Tanpress

* Tmpaess s fully infegrated with the other programs

1the Operddfiice ore muite

# You can eate a rew presentation not oy from

writhin Inpress but also fiom Water and Cale

* Vo can open e seisting poes sxtation fioa

Ingress, Witer oz Cdle

+ OpenOffice. ong will sutommsticallyactivate the

Tpress stttorumert when needsd

* limpeess has 2 fll set of editing features for

* ¥ou can copy from o er pesentationorfiom a

* If you o bt et in Wader them yom

copine, i and formatting

doouzend orfiom a spreadstest inlo the quent
presemation.

astomatically lnaw bovr to editin Ingress

Workspace view: Outline

In Outline view, the slide is displayed in text form and is very useful for editing purposes. It
can be used in conjunction with Preview as shown on the following screen so that you can see

Slids 1

what the finished slide will look like.

Slida 2

Siida 2

[Times Newromaz] [44 7] B i U &| =

Ee ot b |@e|E
1

[ e SR s S

@

7

e & Gt Tl - e I S e | e

Impress

& [ntegration

1 [N]

Calc.

when needed.

z = OpenOffice.org

The features of Impress

* Tmpress is fully integrated with the
other programs in the
OpenOffice org suite

* You can create a new presentation
not only from within Impress but
also from Writer and Cale.

* You cah open en existing
presentation from Impress, Writer or

* OpenOffice.org will automatically
activate the Impress environment

Integration

* Toupress is fully integzated vrith the other progzams
inthe OpenOffics crg suits

* Yom cancreate a ey presentation not only fom
within Inpress bt aleo fiom Witer and Cle,

& Vem canopen en existing poesentation fiom
Tnagoess, Waiter orCale

* OperOffice. crg will amtonatically sctivate the
Inpess exvvitonment when nesded.

Tn

[Ceo% [« Bligez 13

[pefaur
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Workspace view: Notes

Using Notes view, you can add notes to a slide for later use. These will not be displayed when
you show the presentation, but can be printed.

§ = .00em ;g'i Black 7| & [cotor 1"i Blue 7 1{ ] fﬂ

EE?E} 123 4567 8 9101112131415161

Integration
* lrpress i fully itsgrared vrith the other prograns
i the Open(ffice org suite
* Voucan coeate & e presentation ot only from.
ess bt also from Wiriter and Calc
* Yousinop e enedting preatsim o
Teepress | Wiiter or Calc

* OpenOEie org will sulomatically activate e
Terpress enviopment whenneeded

<lickto add notes

ARG (€nwme LLiReR2 S [FT

28 27 2§ 25 24232221 201918 1716151413121110 9 8 7 6 5 4 3 2 1 1

L}

[ a0 12020 4 .00 x 000 ag% [ Blidez 3 Defautr

Workspace view: Handouts

Handouts are printed copies of a presentation. You may view a presentation as it would appear
on the printed page in Handouts view.

:jlu D0cm jj'i Blark 7| E@%_]cmm i‘."i Blue 7 | D@

3 2 1 1 2 3 4 5 6 7 B 9 10 11 12 13 14 15 16| 17 18 19 20 21 22 23 24 25 P6 27 28 2§ 30 31-

OpenOffice.ory
v & Integration

Impress

* Dpress s fully e grated vrith the othur prograns
i the Openfffice org suite

* Vom cazcreate 8 2wy presentation not ondy fram.
wrihin Tpes s b also from Writsr and Calr

Thue astares of Iepress # Y om can op e e existiuZpTe entation fram.
Ipress, Wiiter ar Cak

* Open Office org will stamatica Ly activite the
Taxpress sxwvinoanent when nae ded.

Full editing features

* hmpre ss hus & fll set of e ditiyg feamires for
copying moving and frnmatting.

* Yo can copy from sother presentarion oy from
document r from & spreadshest into the amrent.

Meanhy e nne(lliheEd % [F

=+ Dresarzation,
* I you oo v hovy to e dit i Wiiter ther you
g ot ally knovr hovr t0 edit in brpress
| @
r

[*1 1693 ( 16.09 M 000%0.00 “6o% | * Bilde1 /1 [Default
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6.2.1.2 Change between presentation view modes

This section will only be concerned with switching between workspace views. Master slides will
be covered in section 6.2.4 while layers fall outside the scope of these notes.

Preview
You can switch on a preview at any stage. The preview can co-exist with the view mode.
* View >> Preview.

The preview can be closed by executing this command again or by pressing the close icon in
the top right hand corner of the preview.

Workspace Eile Edit BOUCHH Insert Format Tools SlideShow Window Help
. . | 0 Eeaas i
The different workspace views are accessed =i Tooibars ;
via the commands: ] 0 o Ruers Pl Dfcoior  v][EE B
ij_j:" =ttt § 7 8 9 10 11 12
- View >> Slide. |~
+ View >> Workspace. Ll orkspace v DrawingView  Crri+F12 |
- Select the appropriate view: Tl Display Quality v Qutline view P12
Drawing view 1 T indes:few
OUtIine VieW @ Preview Mode " ;Dte: ::'_
- - o Aandout i ew
Slides view o Siide
Notes View T Master v
Handout view. | o Layer
g |~ Grid v
(€ = Shap Lines 3
Bl | Full Screen Ctrl45hift+

6.2.2 Slides

The only way to master an application is through practice. The following sections
2 explain how to carry out the various tasks. You should create a presentation for
yourself similar to the one used in this example. Use this for practicing the different
techniques.

6.2.2.1 Add a new slide with a specific slide layout such as: title slide, chart
and text, bulleted list, table

Suppose you start with a blank presentation. To create the first slide:

+ Insert >> Slide.
» Use the name Title for the slide.
» Select Title slide as the Layout and click OK.

For the moment, we will work with the defaults that are supplied when we select a layout.
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§ 4 3 2 1 A 8 8 10 11 12 12 14 15 16 17 18 19 20 21 22 23 24 25 26 27 B 79 30 31 32

Click to add title

Click to add text

by € hme |l iReR T

14 13 12 11 10 9

The title slide comprises two areas, one for the title and one for additional text. If you click on
one of the areas, the message in it will disappear and you can begin typing.

* Create a slide similar to the one shown below.

2| ¢ =dfcontiuouz]oooem CMMeeck =] Hfcoer  FfMene; o] DR

4 3 z 1 1 2 3 4 5 6 7 & 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 2B 29 30 31 32

Andromeda
Science and Technology Centre

Let your mind and spirit
soar to the distant galaxies

880 6|hme|Ll anel- T

15 14 13 12 11 10 9

File >> Save as.

Navigate to a suitable directory, give the slide show a suitable name and save.
« Insert >> Slide.

+ Enter the name Features.

+ Select the Title, Text layout and click OK.

« Complete the slide as shown on the next screen.
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o e Lt~ |
i Q*_'EI 1.'{|_nnncm | eack j ;&i'cmnr :”.BIue? j l:i

E 4 3 2 1 1 2 3 4 5 6 7 8 8 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24| 25 26 27 2§

Features

Interactive exhibits

Displays

Photographic galleries

Telescope

Computers

Y [H[hme | L

15 14 13 12 11

Videos and films

il

Scientific and technological games

« Insert >> Slide.
« Enter the title Entrance fees, and select Title, Spreadsheet layout.

The spreadsheet layout can be used for creating tables in a slide.

» Double click on the Spreadsheet icon in the slide. This will display the spreadsheet.
+ Create the slide shown below.

27 26 25 24 23 22 21 20 18 1§ 17 16 15 14 13 1 11 1o 8% & F & &5 4 3 2 1 1} 1 2 3 4 5

Entrance fees

c | o e [ r | c | u
day Ullbdnsdayl tursday | Friday | Saundsy | Sunday

RIOOOD | R0O0 |

RIDOD | RIDOO | RIDOO

| RDOD | RIODD

e | RGO | B | RS0 | ROOG | RONDY | e

Of mp g8 >

« Double click outside the spreadsheet and it will display as a table.
+ File >> Save.
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Suppose you wish to insert a slide after slide 2.

+ Click on the Features tab to make this the current slide.

E .EI|IE| i | 4 | 4 |Hh TitIE‘}.,Featuresf Entrance fees f [

+ Insert >> Slide.

« Enter the title Telescope and select the Title, text, clipart layout.

« Double click on the clipart icon. You will then be prompted for the location of the graphic
image. Locate a suitable image and insert it.

+ Complete a slide such as the one below.

i a4 5 2 1 | 1 2 3 a4 s & 7 =8 9mn12131415161718192021!?223242526_2?25_'2'9

Telescope

View the heavens through
our powerful
astronomical telescope.

(=)
=
=
£
xl
-
2
5
2
&

‘? The text area will initially have a bullet. You can remove this by clicking on the bullet
icon on the Object bar. In this case, you will also need to reset the indents to 0 using
the Format >> Paragraph command as in Writer.

+ File >> Save.
Now insert another slide.

+ Insert >> Slide.

» Enter the title Entrance Fees Chart and select the Title, Chart layout.

« Double click on the chart icon. A default chart will appear. Right-click on it and select Chart
Data.

» This will open up a mini spreadsheet.

* You will need to replace the default data and also create some extra rows and columns
using the icons on the toolbar, to make it look like the example below.

* When finished click on the last icon on the toolbar which will send the data to the chart
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and update it.

E Chart Data

D
Wed
CF =n UL[E] ) s
Students |5 o |5
Adults 10 [Te |10
Pensioners |0 3 ‘o

ul e-:’w. o Ml

-4
|

+ It should look like the one below on completion.

[ siack =] 2 [Color

IR

] B 7
1 P TS S S

Entrance Fees

[ Children U10
[l Studerts

[ Adulis

[ Pensioners

« Click File >> Save.
- Create some additional slides. Experiment with using the different layouts.
« Use the different Workspace views.

6.2.2.2 Change between built-in slide layouts

You can change the layout of a slide.
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+ Go to the slide that you created called Features.
- Format >> Modify layout.

- Select the Title, 2 Text Blocks layout. Impress refers to Bulleted Lists as Text blocks.

a Impress will warn you that this could lead to a loss of features. Be very careful when
changing the layout of a slide. You can always use Edit >> Undo or Ctrl+Z if the
result is not what you had expected.

6.2.2.3 Change background colour on specific slide(s), all slides
The default background of slides is white. To change this:

- Format >> Page.

« Click the Background tab.

- Click Color.

- Select a colour from the palette and click OK.

+ You will then be asked whether you wish to apply this background to all pages. If you
answer No, the background will be applied to the current page only.

Apart from a uniform colour, you can use the same method to apply a Gradient, Hatching or
Bitmap to the background. These are illustrated below.

[ Filinenid Blia avas linke ks

[

A Prrsmetama

Fill Fill Fill
" pone " Harching " Nane T None ™ Hatching
i Caolor " Bitmap " calor ¢~ Bittriap " Color
" Gradient " Gradient
I: Gradient 1 = E=—= Elack 0 degrees Blank 1=
I cradient 2 2757 Black 45 dearees Sky
Bl cradient 3 FRaan] Black -45 degrees B wiater
[ ] cradient 4 [T Black 90 degrees B Coarse grained
I cradients Red crossed 45 degrees BB cpace
n Cradient & Red crossed 0 degrees m Metal
E Linear blue fwhite Elue crossed 45 degrees Droplets
- Fadial greenfblack Elue crossed 0 degrees Marhle
[ Rectangular red frhite \EEHE Blue triple 90 degrees 50 Linen
] square yellow fwhite [~7] Black 45 degrees wide BT stone
I Linear magentafgreen (. B Mercury
[0 Linear yellow fbrawn BEEEE Cravel
[ Radial red fyellom SRS wrall
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6.2.3 Using Desigh Templates

Design templates are predefined formats for presentations. To use this feature you make use
of an Autopilot. They may be used to create a presentation from scratch or they may be

applied to an existing presentation.

6.2.3.1

- File >> Autopilot >> Presentation.
Page 1 of the Autopilot is displayed.

If you wished to create a new presentation
from scratch you would click Empty
presentation and proceed.

In this case you will use a design template
to create a new presentation.

+ Click From template.
» Select Introducing a new product.
+ Click Next.

+ Select an Output medium, for example,
Screen.

+ Select a Slide design.

+ Click Next.

Apply an available design template to a presentation

AutoPilot Presentation (Introducing a New Product)

71 L

Type
" Empty presentation Intoducing a New Product
£ Open existing presentation
Presentations LI Title
Introducing a Mew Product
Recommendation of a Strategy
¥ Preview
Help | Cancel | ¢ Back | Mext 55 I Create

AutoPilot Presentation (Introducing a New Product)

L

w_fin

Select a slide design

-

IPresemtatlom Backgrounds

éE‘lar kBlue with Orange
Subtle Accents

Select an output medium

Introducing a Mew Product

" Original & Screen
- Owerhead sheet - Slide
¥ Preview
® Paper
Help Cance| <+ Back | Mext > > I Create
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« Select a transition Effect.
« Select a transition Speed.

You can also set whether you need to
manually move to the next slide or whether
this must be automatic. This is the
Presentation type. If you select Automatic,
you can also set the Duration each slide is
displayed.

Select a Presentation type.
Click Next.

» Fill in additional information and notes
about the presentation.
* Click Next.

The Design template comes with a number
of pages.

- Leave the ones you want and deselect the
others.

« Click Create.

The presentation will be created.

AutoPilot Presentation {Introducing a New Product)

-4 ;
2 ETE e e

Select a slide transition

Effect

|Cruss—Fade FromLi™
|Medium bl

Select the presentation type
g Default

Speed

' Auromatic:

Duration of page

00:00:10 B

troducing a New Product

Duration of pause o0-o0-10 _:3 ¥ Preview
¥ Show logo
Help | Cance| | << Back

| Mext >> I

Create

AutoPilot Presentation {Introducing a New Product)

. 0"/

Describe your basic ideas

What is wour name or the name of your company?

Whatis the subject.of your presentation?

Further ideas to be presented?

Help | Cance| |

<< Back |

iMext >

Create

AutoPilot Presentation (Introducing a New Product)

x|

-
S+

Choose your pages

~ 10
™ Long-term Goal
[V Customer Wishes
[¥ Fulfilling Customer Needs
¥ Cost Analysis
[¥ Strengths and Advantages
¥ HextSteps of Action

[~ Create summary

Help Cance|

introducing a New Product

Iv Preview

<< Back

Texts

Create!
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a1
Eile Edit Yiew Insert Formar Tools SlideShow Window Help
[ i [ TR I e e |
|
7| ¢ = ~|[ooem ZiMMenck x| Sfcor  ~|[EHsuer x| @R
\j[iJLz 1 12 3 4 5 & 7 8 9 10 11 lz1314151517wa\quzuzzzazazszs272%L279i3ﬂ|5=
g Y - ki
. =
| Introducing a New Product
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2|
42 w
o |~
; ©
|:|E‘D @
Ll 2
. B
— o
2] .,
&l
= I
.
—: -
2
2
E 3
JED &l tle /_Long-term Goal / Customer Wishes  Fulfilling Customer Meeds f Cost Analysis f Strengths af| 4 3
[ [ i1903 71619 [Tom% [« Buce /7 t-ciarkbiue
distart| | @ ) B B | 2 tmpress...| [} androm. .. | 2 openof.. | [l untited... |[[ untite... |2z AT S iz

Each of the pages has an appropriate layout.

- All you have to now do is fill in the detail on each page as you did when you inserted a new
slide using a standard layout.

At any stage in the creation of a presentation using Autopilot you may click Create.
Impress will then use its default settings from that point on. The settings you use each
time become the default settings for Autopilot.

6.2.3.2 Change between available design templates

You may use the design template of another presentation to change the design of the current
slide.

In this example, the design of a slide in the Andromeda presentation will be changed to the
design used in the NewProduct presentation.

+ Open the Andromeda presentation.

* Go to slide 2, Features.

+ Format >> Styles >> Slide Design.

* Click Load.

+ Select Presentations in Category.

+ Select Introducing a New Product in Templates.
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slide Design x|
Selecta slide design
Ok |
i I| || —| Cancel I
{Load slide Design x|
Categories Templates ok
Default Introducing a Mew Product
Presentation Backarounds Fecomrmendation of a Strategy Cancel
Presentations
Help

More > > |

Default
[T Exchange background page

Load... |

[ Delete unused backarounds

- Click OK.
« Click on the design and click OK.

The two following screens show the second slide before and after the application of the new
design.

You have to be in Drawing view in order to use this feature: View >> Workspace
>> Drawing View.
You cannot apply the new design to more than one slide at a time.

1234567B9mH12]3141515]718192#212223242526272 I 2 3 4 5 & 7 B S 10 11 12 13 14 15 16 17 18 19 20| 21 22 23 24 25 26 27 2

Features
Features

*Interactive displays *|nteractive displays

i *Displays
Losplays *Photographic galleries
*Photographic galleries *Telescope
“Telescope *Computers

*\Videos and films
sComputers

*Scientific and technological games
*Videos and films

sScientific and technological games

If you are unhappy with the result, you can use Edit >> Undo: Presentation Layout
to revert to the original layout.

2
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6.2.4 Master Slide

The Master slide is a slide that contains elements that are common to all slides. You could, for
example, put a watermark or graphic on the master slide. Alternatively, you could insert a
background that will be common to all slides.

6.2.4.1 Insert a picture, image, drawn object into a master slide. Remove a
picture, image, drawn object from a master slide

Insert graphic

In this example, you will insert a graphic and a background on the master slide of the
Andromeda presentation.

+ Open the Andromeda presentation.
* View >> Master >> Drawing.

# Just like any other slide, the Master slide can be opened in a number of views:
Drawing, Title, Notes and Handout.

,? Clicking in either of the two boxes that are displayed enables you to change the
format of the title and outline text. Ignore these.

- Insert >> Graphics >> From file.

« Select an appropriate graphic, resize as appropriate and drag it to the top right hand corner
of the master slide.

[ 1 2 3 4 5 |6 7 ® @ 10 11 12 13 14 15 16 17 18 19 20 [21 22 23 24 25 J6 2r 28 29

=

* Click to edit the outline text format

- Second Outhine Level

a Mhilecd Fudlica T axral

 View >> Slide.

« Scroll through the slides. Notice that the graphic appears in exactly the same position on
each slide.
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T4 3 2 1 1 2‘3 4 5 6 7 8 3 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 25 23 |

! Telescope

View the heavens through
our powerful
astronomical telescope.

a

11 10

Delete graphic from master slide

* View >> Master >> Drawing.
» Click on the graphic and press Del.
* View >> Slide.

Use Main Toolbar

The Main toolbar contains a number of icons that are relevant in the creation of drawn
objects. The following brief introduction is derived from the Help of OpenOffice.org.

The Main toolbar, attached to the left side of the document window, provides access to
common editing tools. Tools with multiple options are indicated by a small triangle. Long-click
the triangle to open a floating toolbar.

By double-clicking a tool, you can use it for multiple tasks. If you call the tool with a single-
click, it reverts back to the last selection after completing the task.

by

To select an object on the current slide, click the Select tool, , on the Main Toolbar, and

then click the object.
To select more than one object, hold down Shift while you click.

To select an object that is behind another object, hold Alt, and then click the object. To select
the next underlying object in the stacking, hold Alt, and then click again. To return the
selection to the previously selected object, hold down Shift + Alt, and then click.

To add text to a selected object, double-click the object and type or enter your text.
To remove a selection, click anywhere outside the selected object, or press Esc.

The following is a reference table to the functions of the icons on the Main toolbar.

[ Selection: Allows you to select objects in the current document.

&} Zoom: Reduces or enlarges the screen display of the current document. Click to select
the current tool or long-click to open the Zoom floating toolbar.
[
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T Text: Long-click to open the Text floating toolbar, where you can add and place text
anywhere on the current document.

@, |[Rectangles: Long-click to open the Rectangles floating toolbar, where you can add
rectangular shapes to the current slide.

g |Ellipses: Long-click to open the Ellipses floating toolbar, where you can add ovals and
circles to the current slide.

3D Objects: Long-click to open the 3D Objects floating toolbar, where you can add
3D shapes to the current slide.

~# |Curves: The Curves floating toolbar contains icons for drawing lines.

_t |Lines and arrows: Long-click to open the Lines and Arrows floating toolbar, where you
can add straight lines, lines with arrows, and dimension lines to the current slide. If you
want, you can add an arrow after you draw a line by choosing Format - Line, and then
selecting an arrow style from the Style box.

n} |Connectors: Long-click to open the Connectors floating toolbar, where you can add
connectors to objects in the current slide. A connector is a line that joins objects, and
remains attached when the objects are moved. If you copy an object with a connector,
the connector is also copied. There are four types of connector lines:

- Standard (90-degree angle bends)
+ Line (two bends)

« Straight

« Curved

C¢ |Effects: Modifies the shape, orientation or fill of the selected object(s).

e= | Alignment: Opens the Alignment floating toolbar, with which you can modify the

< alignment of the drawing. The Alignment icon is only shown when a drawing object is
selected.

LT |Arrange: Changes the stacking order of a selected object.

¥ Insert

g | 3D controller: Specifies the properties of a 3D object or converts a 2D object to 3D.

Insert a drawing object into the Master slide

+ Open the Andromeda presentation.

+ View >> Master >> Drawing.

* Click on the Ellipse icon on the Main toolbar.

» Create an ellipse in the top left hand corner of the Master slide.
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9 101 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 ZE 29

ick to edit the title text format

m Al 4 At Hlaa b liae ~ F et i a

* View >> Slide.
« Verify that the ellipse appears on each slide.

Delete a drawing object on the Master slide

+ View >> Master >> Drawing.
» Click on the ellipse.

* Press Del.

* View >> Slide.

Insert text on the master slide

+ View >> Master >> Drawing.
* Click on the Text icon on the Main Toolbar.
« Insert the text box in the top left hand corner and enter some text.

21 20 1% 18 17 1& 15 14 13 12 11 10 8 & 7 & 5 4 3 2 1 X 1z 3 4 £ 5]

F’//7/////7/////&’/////7//////7/,’

gAndromeda

e e

Click to edit the title text format

* Click to edit the outhine text format

+ Click outside the text box.
* View >> Slide.
« Verify that the text appears on each slide.

Delete a text box on the master slide

* View >> Master >> Drawing.

» Select all the text in the text box by pressing Ctrl+A and press Del.
+ Click outside the text box.

* View >> Slide.
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6.2.4.2 Add text into Footer of specific slides, all slides in a presentation

A footer is an area at the bottom of a slide where you may add text or graphics. A footer may
also have a frame or a background fill colour. A header is likewise an area at the top of the
slide for inserting text or graphics.

Add a footer or header to all slides in a presentation

Headers and footers are created by inserting a text box at the top or bottom of the master
slide.

+ Open the Andromeda presentation.
* View >> Master >> Drawing.

» Click on the Text icon on the Main toolbar, T .

» Insert the text box at the bottom of the Master slide. Drag the ends so that it covers the
entire width of the slide.

+ Type Andromeda into the Text box.

* Click the Centring icon on the Object bar.

T OINITIMLL JULLITIC L.evEl

Andrc:meda

* View >> Slide.
» Verify that the footer appears on each page.

Insert a footer on a single slide

* View >> Slide.
* View >> Workspace >> Drawing view.
» Use exactly the same method as was used to insert the Text box onto the Master slide.
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Change the fill colour or background of a EENEE——— X
footer Areal Shadowl Transparency Cnlnrsl GCradients | Hatching I B\tmapsl
Properties
+ Click on the Footer text box to select it. fore - IS el
alor ellow i i
- Format >> Area. capr [T vetow2 H oy |
. Click either the Colors, Gradient, Ia.”:a".””.d.... . e |
Hatchiqgt orb Biktmapsdtab to select an ;=;i:|!!E\E_ e
appropriate background. Il & [ o
. i EEEEEEEE | -
Ma_lke a selection. EEEEEEEE ¢ = I s
« Click OK. !.....‘\ B 153 =
. R Ll
. EEENEEEE _|
O TEEEE
HEEEEETT
QK I Cancel Help Reset

Delete the footer

Use the procedure described in section 6.2.4.1 for deleting a text box.

6.2.4.3 Apply automatic slide numbering, automatically updated date, non-
updating date into Footer of specific slides, all slides in a
presentation

Insert automatic slide numbering

« Open the Andomeda presentation.

- View >> Master >> Drawing.

+ Create a footer area using a Text box as before.
« Position the cursor inside the footer.

- Insert >> Fields >> Page Number.

+ View >> Slide.

- Verify that each slide is now numbered.

Inserting other information into the (Eile Edit View JUEHY Format Tools SlideShow Window Help
Master slide | S Skt -NE
L (s Duplicacs Slide —_—
The same method allows you to insert other [ Sy rom: & Fomcie El==|==|
fields into the text box. These are: _]: S Side =
- Date (Fixed) v Tl T o~ ()
- Date (Variable) l;:r: o ' | 3B special Character... Date (variable}
- Time (Fixed) — |~ G Hyperlink Tirne ffixed)
. . ||| 22 " .
- T|me (Vanable) (= sean . Tirne fvariabley
- Author B = i
_ Flle Name GE % E Spreadsheet
1 K e Eile Name
- . - | = Object v =

Fixed date and time will insert the current ~& "

. . i & Chare
date and time. These will not change. b :

. . . . =l =z [ Floating Frame...

Variable date and time will adjust to the |~
actual date and time. il ([ By Eile..
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Although the page numbering was inserted into a footer, the same method could have
been used to place it anywhere on the slide.

You can also use this method to insert a field into a single slide.

Change the date format

« Select the date in the text box.
- Right click to display a context menu.

Ei‘| TOOLLLLLAL VUL LY el

o - Fourth Outline Level .
~ + Fifth Outline Level Lo

ol ¢ Sixth Outline Level & Sarishie

" + Seventh Outline Level el

. *+ Eighth Outline Level SEnREE A

: 01/16/04

+ Ninth Outline Level =k :
01¢16/z004

[an 1§, 2004
January 16, z0o4
Fri, January 16, 2004

Friday, January 16, 2004

Hesraa
- ]. ."II ]. 6.-"I et

+ Select a date format.

Page 6.46



Module 6: OpenOffice.org Impress

Section 3: Text and Images




6.3 OpenOffice.org Impress: Text and Images

6.3.1 Text Input, Formatting

6.3.1.1 Add text into a presentation in standard, outline view

Unlike in a word processing document, text cannot be inserted directly into a slide. A text box
is a container that holds text. Before inserting text, you need to first insert a text box and the
insert text into that.

A text box and its text can be treated as an object like a graphics image and can be dragged
to different positions on the slide. It can also be resized. The text can be formatted in the same
way as text in a document.

Insert text into a slide in standard (drawing) view

+ Open the Andromeda slide.
» Insert a new slide after the Telescope slide. (Click on Telescope, then Insert >> Slide.)
* Use a blank outline.

A blank outline is useful if you want total control over the structure of a slide. You will
need to insert all the objects and containers manually.

You can add a name to the slide after you have created it. Right click on the tab of the new
slide. This will display a context menu.

é,a Insertilide...
Delete Slide. ..
o] Madify Slide...

21 20 19 18 17

Ty CErI+Y B

=

_ 4= I:I{IElui q i » ibll.\- Title ,(.Features ;(_Telescope.a\}\_SIide 44 Entrang {4 1

]

| 2 6.46 1 21,48 % .00 x 0,00 [ s [+ klidears Default

Notice the options (Insert, Delete, Modify, Rename).

Click Rename and give the new slide the name Computers.

Click the Text icon on the Main toolbar and insert a text box into the blank slide. Position
it at a position of your choice. Type the words There are a large number of the latest
computers available for your use into the text box.

You do not need to worry about the size of the text box. It will expand downwards as
you type to accommodate the text you type. You can manually resize it later sideways
if you wish.

Move the text box by hovering the mouse over one of the perimeter of the text box until a
pair of crosswires appear. Hold down the left mouse button and drag the text box to
another position.

Insert and resize some computer graphic images on the slide as shown on the following
screen:
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1 ) 3 < S o 7| =) a m 11 12 13 14 15 16 17 18 189 20 21 22 23 24 25 26 27 2

There are a large number of
computers available for vour use

If you wish to insert a title on a slide, rather use the Title only layout.
Insert text in outline mode

» Right click on the Computers tab and select Insert slide or Insert >> Slide.
+ Select the Title only layout.

* Give the new slide the name Videos.

* View >> Workspace >> Outline or press | on the Vertical scroll bar.

+ Enter the title Videos on the first line of the new slide.

To] 1 2 5 dc Bt BB B0 A1 2 A5 A4 05 15 A7 NB N8 20 21 22 23 24 25 -

& Features
* Interactive displays Videos
* Displays
* Photographic galleries
* Telescope
* Computers
* Videos and films
* Scientific and technological games

& Telescope

View the heavens through our
powerful astronomical telescope.

Bl

& Videos
& Entrance fees

i I»I;‘

Notice that the previous slide did not have a title, hence this is blank on the title line. The title
you entered for this slide will automatically be inserted into the title text box.

+ Press Enter at the end of the word Videos.
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This will insert a new slide.

« Press Backspace to delete the new slide.
« Click on the blank title line of the previous slide and type the word Telescope.

Even though you used a blank slide, Impress will insert a text box in the correct position for a
title and enter the text into it.

* File >> Save.

* Switch back to Drawing mode using View >> Workspace >> Drawing or by clicking o
on the Vertical scroll bar.
* Go to the Videos slide and insert some text and graphics as shown on the next screen.

1 2 3 4 5 6 7 & 9 10 11 12 13 14 15 16 17 181920212223242526272E

Videos

Up to date videos on the latest scientific
and technological advances

Videos suitable for all
levels of knowledge

L

* File >> Save.
* File >> Close.

6.3.1.2 Edit slide content, notes pages content by inserting new characters,
words

Edit a text box
You can edit text boxes at a later stage.

« Open the Andromeda presentation.

« Click on the Videos tab to jump to the slide.

+ Click on one of the text boxes. Position the cursor inside the text box. You can now edit the
text in the same way you would in a document. Modify the text box as shown on the next
screen. You can delete and insert text as you wish.
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G e A L L L /////////:g

“Videos can be selected| for g
7all levels of knowledge Z

é::////////////////////////////E///////////////////////////fﬁ

« Click outside the text box when done.
« File >> Save.

Add and edit notes

Notes refers to text that is stored 3 2 1 Tl 2 3 4. 5.6 7 8 3.10]1121314451617 1
along with the slide, but is not
displayed during a presentation.

Notes have a number of uses:
- They can serve as an aid to the

speaker. Videos
- They can be used to record

thoughts in the development of a o date i o e Lo i
tuchro b gz al slve o

presentation.

+ Open the Andromeda
presentation.
- Go to the Videos slide. '  —
- View >> Workspace >> = —
Notes view. M
+ Add some notes as shown in the
adjacent screen. e L e e
. View >> Workspace >> ZThe gaphicsin this dide need to be impr oved,
D_rawmg view. S,
- File >> Save.

Wileor e e mlecid for
Al kwls of ko wled @

‘\\\é

LI
[ S S

et presentingthe dide, emphasize the range of
Wdeo material that 1z available.

I SRS

6.3.1.3 Change text appearance: font sizes, font types

Text can be formatted in exactly the same way as in a word processing document. Font style,
size, enhancements (bold, underline, italic) and colour can be changed.

When the Andromeda presentation was created, the text used in the Videos slide was Times
Roman 24 pt. Depending on your installation, the default font may have been different. In
this section you will change the font style and size.

* Go to the Videos slide.
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Click on the first text box.
Highlight all the text.

+ Change the font style and size using the Object bar as shown on the next screen. Use a

different font style and size of your choice.

[arial -l[@~ B g£|

o8& || =

Click on the second text box and highlight
only the words all levels.

This time change the font style and size
using Format >> Character and selecting
the Font tab.

Click OK.

File >> Save.

S ﬁ—_l__s__5__4§g =3 2 1L 2,3 4 5 6 7,8 9 10 11 12 13414 15 16 17 18 19 20 21 22 23 24 25 26 27

§ 0 i

=l " 36

T 40

= 44

i 14 48w "

el Videos

2|~

_i: ] 5’ G i, /////////////g

ol Up to date videos on the latest g

i “scientific and technological B

el ~ ~
Eadvances 7

AN d g .

antl Font Effects | Position |
Fant Typeface Size
Regular
Arial Black Italic
Arial Marrow Bold
Bitstrearm VeraSans Bold Italic
EBitstrearn VeraSans Mano
EBitstrearn Vera Serif
Rnnk &ntinns Li

Language

|"‘i°z English (USA) 'I

all levels

The same font will be used on both your printer and your screen

QK I Cancel | Help |

Beset |

6.3.1.4 Apply text formatting such as: bold, italic, underline

The same method used in the previous section to change the font can be used to apply
enhancements such as bold, underlining and italic to fonts.

» Click the appropriate icon on the Object bar,

Select the text.

Use this method to make the words all levels in the Videos slide bold.

or use Ctrl+B, Ctrl+I or Ctri+U.

‘? If you click on a word without actually highlighting any letters and then click on a icon
on the Object bar, the enhancement will automatically be applied to the current word.

Page 6.52



6.3 OpenOffice.org Impress: Text and Images

6.3.1.5 Apply case changes to text

You may change the case of selected text to upper or lower case.
« Go to the Entrance fees slide.

« Select the text in the title.

- Format >> Case / Characters >> Uppercase.
- File >> Save.

6.3.1.6 Apply different colours to text

+ Go to the Entrance fees slide and select all the text in title.
Click on the font colour icon on the Object bar.

ITimesNewRoma;I |44j B : U £| = E = | =

Ml e 5 4 5 2 1 X TS A l% L9 10 11 12 13 14 15 1§ 17 18 19 20 2] 22 23 Ad 25 26 27
_b Tiie | A utomatic = :
Lrll - ENEEEEEN -
Ll Z’/////z ;=;i[|!|!’l:i— A | § ////////////////////////////////////.%
m| D CTPANTRANCE FEES
@ § EEEY, TR : i g
o | EEER__E /
N 7 EIEEEEEE .
el 2, IEEEREEE g
| ||| e
-3 ....-ﬁr'—j \ifednesday  Thursday Friday Saturday Sunday
D-Lg L Childre Red 4 Free Free Free Free Free

» Click on a colour, for example, red.

Click anywhere on the slide.

* File >> Save.

* Go to the Computers slide and highlight the words large number.
+ Format >> Character and select the Font effects tab.

+ Select a colour and press OK.

Font color [ Sutline

LUtomatic

Bl Light biue -]
D Light green e
|:| Light cyan

T - Light magenta
|:| Yellow
[ ] white -

[ Shadow

large number

+ File >> Save.
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6.3.1.7 Apply shadow to text

The method of the previous section can be used to apply a shadow to text.

» Highlight the title of the Computers slide.

- Format >> Character and select the Font effects tab.
+ Tick the Shadow check box.

« Click OK.

6.3.1.8 Align text: left, centre, right in a slide

You may align text within a text box in the same way that it can be aligned in
tables and pages of a document page. Click anywhere in the text and click
the appropriate icon on the Object bar.

« Go to the Videos slide.
« Click inside the first text box.
« Click the centring icon on the Object bar.

Left aligned (default) Centre aligned
Up to date videos on the Up to date videos on the
latest scientific and latest scientific and
technological advances technological advances

i 1 Ifr%n‘\ll I ‘ ||®.||

6.3.1.9 Adjust line spacing before and after bulleted, numbered points

When you insert a bulleted list, Impress inserts a certain amount of space after each item. This
is usually 0.50 cm. You may change the amount of space insert both before and after items.

+ Go to the Features slide. This contains a bulleted list.
- Highlight the bulleted list.
- Format >> Paragraph and click the Indents & Spacing tab.

+ Use the Above paragraph and Below paragraph spin windows to set the amount of space
inserted before and after each item as shown on the next screen.

Spacing
Above paragraph b.] Ocrnm o

EBelow paragraph 0.70cm =

Line spacing

Single _V_I it

JUE
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Notice that you could also have set the line spacing of the bullets at this time. If you
were to use line spacing, then this would also be applied between multiple lines of the
same bullet item.

6.3.1.10 Change between the style of bullets, humbers in a list from built-in
standard options

There are a number of bullet styles available. i
You may Change the Style of the bu”ets' Bullet5| MNumbering type | Craphicsl Paswtioml Custom\zel
Selection
+ Select all the bulleted items in the £ ® * i
Features slide. ® % i
« Format >> Numbering / Bullets and
click the Bullets tab. . ™ Py ™
« Select a style of bullet and click OK.
> » X v
> > X v
= > X v

QK I Cancel | Help | Reset

6.3.1.11 Use the undo, redo command

When we execute a command on some text, for example delete the text, we are able to
reverse what we have done. This is known as the undo function. It is also possible after having
undone the change, get it back. This is called the redo function.

Impress actually keeps a history of recent changes you have made.
Undo

Pressing Ctrl+Z undoes the last change you made. Pressing it a second time, undoes the one
before that, and so on.

An alternative method is to use Edit >> Undo. When you use this method, the menu will
indicate what type of operation you will be undoing.

-_—

Yet another way of carrying out undo is to press the undo icon on the function bar, *=
Redo
As mentioned above, redo undoes the action of the last undo.

To use this function use Edit >> Redo. As in the case of undo, the menu will indicate the
action that you will be redoing.

You can also execute the redo function by pressing the redo icon on the function bar, +
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Suppose in the previous section you were unhappy with the change.

« Edit >> Undo or Ctrl+Z will change the bullets back to their original form.
+ Edit >> Redo or Ctrl+Y will restore the change.

6.3.2 Pictures, Images

6.3.2.1 Insert a picture into a slide

Unlike text which has to be inserted into a text box, a graphic does not need a container. It is
inserted directly into a slide. Once it has been inserted, it can be resized and moved.

« Insert a slide after the Features slide using the Title only layout. Give the slide the name
Photographs.

» Insert the words Photographic Gallery into the text box.

* Change the text to Arial or Helvetica blue.

+ Insert >> Graphics.

This will display the Insert graphics dialogue. Using this you will locate the directory / folder
containing your graphics images.

The dialogues are somewhat different in Linux and Windows.

Insert a graphic under Linux

» Tick the Preview check box so that you can view each of the images on disk.

Insert Graphics

imnt/win_e/Clipart/Scitech/Space l‘i’iE E

|'I‘|t|e ]Type ]Size ]Date modified
[ B1A SATU.WMF Graphics (wmf) 195 KB 24/07/1997, 11:09:20 :l
E’ ADOD3108.WMF Graphics (wmif) 85.2 KB 30/07/1997, 13:54:18

B ADDD3109.WMF Graphics (wmf) 1387 KB 30/07/1997, 13:54:18
[&f ADOO3144.WMF Graphics (wmf) 133.0 KB 30/07/1997, 13:54:18
[ ADOD3780.WMF Graphics (wmf) 3542 Bytes 30/07/1997, 13:54:18
[&" ADOD3792 WMF Graphics (wmf) 2582 Bytes 30/07/1997, 13:54:18
[ ADOD381LWMF Graphics (wmf) 17.4 KB 30/07/1997, 13:54:18

-
[ AMAADIACT LI [T N PP Prppe——" ) MEC R IAATAAAT 13,0400 J

File name: |AD003109.WMF | Open |
File type: |{Allf0rmats:=- (* bmp*.dxf*.emf*.eps*.gif ¥ jpg:* JpE(_l L&ﬂ‘
_ b |

I~ Link ¥ Preview

» Select the graphic you wish to insert and click Open.
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Insert a graphic under Windows

* In the View menu select
Thumbnails.
Alternatively, check the Preview
check box to display a preview of
the current file.

» Select the graphic you wish to
insert and click Open.

Insert Graphics

Look in: I =9 Space

=l 4=- ck |-

Recent

My Diocuments

"

My Computer

File name:

Filez of tupe:

ADOOE144 . WTF

ADODZ108.\WHMF

ADODIFE0,WMF

® Thumbnails
Tiles.
Icons

List

Details

ADO03109.WMF

ADO037IZWMF

|

j Open I

|<.~'l|| formatss [".bmp;".dxf;".emf;“.eps;".gif;".ipg;“:l

I Link
[~ Freview

« Insert some appropriate graphics into the Photographs slide.

* File >> Save.

Cancel |

v
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Insert graphics using the OpenOffice.org gallery
Another method of inserting graphics is to use the Gallery.

* Go to the Photographs slide.
* Tools >> Gallery.

This will display the graphics gallery.

+ Click Rulers.

« Click on one of the images.

» Drag it onto the slide by holding down the left mouse button and releasing it when it is
below the title as shown on the next screen.

E Andromeda.sxi - OpenDffice.org 1.1.0

File Edit Wiew Insert Format Tools SlideShow Window Help

|E:\OpenSourceBook\Andromeda.sxi ﬂ| @ = 5 || @| JL @| 4:7 -o_-'v| ‘1L j?’ [& |

B, 3D Effects

?&I Backgrounds
e s . ] i B e I —— | | — | L DL i i ] i A — . e
B, Bullets -

Rulers - blurulrd

B Hormepage
?EI My Therme

B Sounds

HER B e ke il s EEEEETST T e e el AR de——
Q ?‘.’;-IContinuousjlﬂ.DDcm _é”. Black j :}&ICOIDr jl- Elue 7 j ' El\

Ni]1s1z11108 8 7 6 5 4321 | 1234567 & 310111213141516171819202]1 222324252627 2829 30 3] 32 33 34 35 36 37 3¢

Photographic Gallery

Lainel= 3 [F )

1098765432][

* Close the gallery with Tools >> Gallery.
* File >> Save.

6.3.2.2 Insert an image into a slide

OpenOffice.org does not distinguish between pictures and images. Hence the methods
described in the previous paragraph are equally applicable to images.
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6.3.3 Duplicate, Move, Delete

6.3.3.1 Duplicate text, pictures, images within the presentation, between
open presentations

The process of duplicating text or graphics is as follows:
> Select the text or graphic to be duplicated.

ERS
> File >> Copy or Ctrl+C or click the Copy icon, , on the Function bar.
> Position the cursor where the duplicate must be inserted. This can be in the same or a
different presentation.

> File >> Paste or Ctrl+V or click the Paste icon, & , on the Function bar.
Copy a graphic within a presentation.

« Open the Andromeda presentation.
- Go to the Photographs slide.
« Click on the ruler graphic under the title that you inserted previously in section 6.3.2.1.

E' b
« File >> Copy or Ctrl+C or click the Copy icon, , on the Function bar.
« Go to the Telescopes slide.

« File >> Paste or Ctrl+V or click the Paste icon, & , on the Function bar.
This will insert the graphic in the same position on the slide.

Copy text within a presentation

The method is exactly the same as copying a graphic as in the previous section.
Copy text or graphics between presentations

+ Keep the Andromeda presentation open.

+ Create a new blank presentation with File >> New >> Presentation.
+ Save the new presentation as Jupiter.

+ Return to Andromeda with Window >> Andromeda.sxi.

* Go to the Telescope slide.

* Press Ctrl+A to select everything on the slide.

» File >> Copy or Ctri+C.

+ Return to Jupiter with Window >> Jupiter.sxi.

* File >> Paste or Ctrl+V.

6.3.3.2 Move text, pictures, images within the presentation, between open
presentations

The process of moving text or graphics is as follows:
> Select the text or graphic to be duplicated.

> File >> Cut or Ctrl+X or click the Cut icon, ¥ , on the Function bar.
> Position the cursor where the duplicate must be inserted. This can be in the same or a
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different presentation.

> File >> Paste or Ctrl+V or click the Paste icon, & , on the Function bar.

Move a graphic between slides within a presentation

Go to the Telescope slide in Andromeda.
Click on the ruler image below the title.

File >> Cut or Ctrl+X or click the Cut icon, ¥ , on the Function bar.
Go to the Computers slide.

w

File >> Paste or Ctrl+V or click the Paste icon, & , on the Function bar.

Move text between slides within a presentation

Use exactly the same method as moving a graphic.

Move a graphic or text between presentations

Select the ruler you just inserted into the Computers slide.

File >> Cut or Ctrl+X or click the Cut icon, % , on the Function bar.
Go to the Jupiter slide with Window >> Jupiter.sxi.
Insert >> Slide and select any layout.

File >> Paste or Ctrl+V or click the Paste icon, &3 , on the Function bar.

6.3.3.3 Resize pictures, images in a presentation

When you insert a graphic into a slide it will often be the wrong size and in the wrong position.

Resize and reposition graphics using the Format menu

+ Open the Andromeda presentation. B
. Go to the Telescope slide. Position and Size | Rotation | Slant & Corner Radius |
+ Click on the image. e G
« Format >> Position and size. Posiion x : e
« Click on the Position and size tab. F et —

o Base point
This gives you details of the position and size Wit [erem = ﬁ
of the image on the slide in actual e [fiom = A_:_J
measurements. P

Protect Edant
+ Make adjustments. & S
» Click OK. L ittt

Ok I Cance| Help Reset
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Rotate image using the Format menu x|
Position and Size Rntntiunl Slant & Corner Radius I

« Click on the Rotate tab in the Position R I
a_nd size_dialogue. ] _ bt [ooicm o F——r——F

+ Either adjust the Rotation angle spin N [ ]
window or click on one of the Default l
settings.

. Cllck OK. Rotaticn angle

Default settings

Angle |b.00 degrees ’:’i i # L
(‘%A
. o

QK I Cance| | Help | Reset |

Reposition a graphic using the mouse

» Click on the graphic and hold down the left mouse button.
» Drag the image to a new position.
* Release the left mouse button.

Resize a graphic using the mouse

When you click on a graphic, handles are displayed in green around the borders of the image.
These can be used for resizing the image. The image is resized by clicking and dragging a
handle.

The corner handles can be dragged in any direction to resize the image. The middle top and
bottom handles can only be dragged in a vertical direction while the middle left and right can
only be dragged in a horizontal direction.

» Click on the image to display the handles.
« Click on a handle and hold the left mouse button down.
« Drag the handle to a new position.

_View the heavens through
our powerful
astronomical telescope.
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A dotted line will indicate the new borders of the image.
« Release the left mouse button. The image will be resized.

If you are unhappy with the result, Edit >> Undo or Ctri+Z.

6.3.3.4 Delete text, pictures, images in a slide
Delete text

» Highlight the text you wish to delete.
* Press Del.

Delete a graphic

» Select the graphic by clicking on it.
* Press Del.
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6.4.1 Using Charts/Graphs

6.4.1.1 Input data to create, modify different kinds of built-in charts/graphs
in a slide: column, bar, line, pie

Create a column chart

Suppose we wished to show how the number of visitors to the Andromeda Science Centre has
grown over a period of time. The following table shows the data we wish to present.

Jan Feb Mar Apr May Jun
9210 9807 11219 9174 14792 17148
sercslide x|
¢ Open the Andromeda presentation. e
» Insert a new slide at the end. Give the slide =] |
the name Visitors and use the Title, Chart  Scl=ctanautstayout
layout. ] me |
» Click OK. — = =
« Add the title Growth of Visitors to the
Centre. EEEEE
« Change the colour of the title to blue. olllod [ [EEEES
* Double click on the Chart icon displayed on
the chart. AERENNE YRS
| i ; Title, Chart ﬂ
Silla)
¥ Objects on backaround

« Double click on the chart.
» Right click to display a context menu and select Chart data.

Growth of Visitors to the Centre

Main title

1 =]

EHEEE EE P sl

= [ s T ¢ [ o 1]

Column 1 column2 | Column 3

1

2 |Rrow: 3z 454
5 |Rowz 2.4 5.5 |5.65
4

5

Row 3 31 1.5 3.7
Row 4 43 .0z 6.2

0 S MW R o @m N @ @
P R i Gk £ S LA A

Rowe 1 Row 2
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The first four icons on the chart are add row, add column, delete row and = B B B
delete column.

* Modify the table so that it contains seven columns and two rows. Then add the data shown
on the next screen.

E
e EE Yo

A | 8 | ¢ 1 o | e | ¢ | o |
1 Jan _Feh _ru1ar Apr _ru1a1,.r Jun
> |Wisitars 9210 9507 11214 9174 14792 17148

* Click the close icon on the chart. x|

» Click Yes to apply the changes. @ Data has been changed.
H :
Do wou want to apply the changes?

This will insert a chart based on the data into the slide. Brps! Mo | Cancel |

Growth of Visitors to the Centre

Main title

18000

16000

14000

12000

10000

2000+

G000+

4000

2000+

Wigitors
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» Double click on the Main title and delete the contents.
» Resize the chart by double clicking on it and dragging the handles on the borders.

You may modify the chart. For example, we can change the scale of the Y-axis so that fewer
horizontal grid lines are displayed.

vads x|
Line | Characters | FontEffects Seale | numbers | Label |

» Double click on the chart to select it. cale aves
+ Right click to display a context menu. Bibirsus ER
+ Select Axis then Y axis. e [leon W aumae
* Click on the Scale tab. Major interval 1500) L
* Uncheck Automatic for the Major Migor irerval so0 b dtonss

interval. Bxisat o R
» Change the Major interval to 1500. ™ Logarithmi scale
« Click the Font Effects tab. Maiot interval marks
» Change the font colour of the Y axis to blue. L et Wioter
* Click the Characters tab. HiAatinteraimer ks
« Change the font to 12pt bold. L Lo
+ Click OK.

,TI Cance| Help Reset

You may add a chart to an existing slide as follows with Insert >> Chart. This will
insert a chart which can be moved or resized. The creation of the chart follows the
same steps that were outlined above.

Modify chart data

» Double click on the chart.

Right click to display the context menu.
Select Chart data.

Modify the data for Apr.

15000 [ ’_
13500 ——— ]
Chart Data #
2000 —
sl —— EHEEEBEE e EE
9000 -
i a2 | s | ¢ [ o | e | ¢ [ a |
6001 1 lan Feb Mar Apr May Jun
6000+ > |wisitors az10 9807 11219 10072 14792 17148
4500

Click Close and accept the changes.
Click outside the chart to deselect it.
* File >> Save.

Modify column

You can modify the data series, ie columns, to change the fill colour and the outline colour.
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« Double-click on the column you want to change.
- A dialog box will appear with tabs to allow you to change the border, area or transparency
of the column.

Create a pie chart

- Click on the Visitors slide.

- Insert >> Slide.

- Select the Title, Chart layout, give the slide the name Ratios, click OK.

+ In the Title text box type the words Ratios of types of exhibits.

- Double click on the chart icon, then right click and select Chart data.

+ Complete the data spreadsheet as shown on the next screen. For a pie chart you must insert
the data in a column, not a row.

Chart Data I #
SIS EE EE YoM Y| W
A A
1 Interactive
Z Interactive 17
3 | Video 12
4 Demnnstrati_43
5 Exhibits 22

Close and accept the changes.
 Format >> Chart type.

+ Select Pie chart (Pies) and click OK.
* Click outside the chart.
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Add labels to a pie chart

* Double click the chart to select it.

* Double click on a segment the pie chart
itself.

+ Click the Data labels tab.

Data Point

Borders I Areal Transparency I Characters | Font Effects  Data Lahelsl

W show walue

" as nurnber

I Show label text

I Show legend icon with [abel

« The adjacent screen illustrates one way of

adding labels.
* Click OK.

+ Repeat this process for the other segments.

* Click on the Legend and press Del.
* Click outside the chart.
* File >>Save.

oK I Cancel Help

Reset

Ratio of types of exhibaits

Interactive 17.00%

Wideo 12.00%

Exhibit 22 00%

L emonstrations 42.00%

Using the same dialogue, you could have changed the font size, style and colour of the

pie segment labels.

# You can use the same method to add data labels to any of the other types of charts.

6.4.1.2 Change the background colour in the chart/graph

Change the colour of the chart area
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* Open the Andromeda presentation.

Chart Area

* Go to the Visitors slide. s, S s

* Double click on the chart.

« Format >> Chart area.

¢ Click the Area tab.

* Click the Color radio button.
e Select a colour.

* Click OK.

The background colour of the chart area will
change.

You could use the same method to insert a
Gradient, Hatching or Bitmap background.

Fill
" Mone " Hatching
& Color! " Bitmap
£ Cradient

] vellow 3

[

E

oK I Cancel

Help

Reset
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Change the colour of the chart wall

The chart wall is the inner area of the chart. It excludes the chart area containing the legend, x
and y axis titles and the title. When you change the colour of the chart area, Impress assigns
the same colour to the chart wall. You may, however, give the chart wall a different colour.

« Double click on the chart to select it.

« Format >> Chart wall.

« A similar dialogue to the Chart area dialogue will be displayed.
e Click the Area tab.

» Select a colour and click OK.

» Click outside the chart.

* File >> Save.

18000
16500 —

15000 ! —

13500 "

12000 =

10500 —

9000 -| | |
7500 —
6000 —
4500 f—
3000 —
1500 - =

Visitors

6.4.1.3 Change the column, bar, line, pie slice colours in the chart/graph
Change default colours in charts
* Tools >> Options.

+ Expand Chart and click Default colors.

Options-Chart-Defaut Colors x
OpenOffice.org
Load{Save Chartcolors —————————— Caolartahle ———————
L Setti i
o - ] ENEEEEEN -
TexuDooumens [ ] Daraseries 3 | .[_l S.rr
?;h:tiic;r:ent [ Dataseries 4 ...|—|—|—r|—
Presentation 5 g::i:::::: ........
Eorra:vnl:‘ga I Daraseries 7 ........
B char g DataSeries 8 L1111 i
Jefault Colors| DataSeries 9
Dataourcs I Daraseries 10 L
DDataSer\esH ...r.ﬁm—'—
B DataSeries 12 |—|—|—|—|—|—..
HEEEEEECT
N EEEE
|| =

Light red

Default |
QK I Cancel Help | Back |
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+ Make changes as desired and click OK.

The changes will apply to all future charts you create.

Change the colour of an individual bar or pie segment

The method described for changing the colour

of a single bar of a chart can also be applied
to changing the colour of a segment of a pie

chart.

* Double click on the chart.

* Double click on the bar whose colour you

wish to change.
e Click the Area tab.
¢ Click the Color radio button.
» Select a colour and click OK.

6.4.1.4 Change the chart/graph type

Change chart type

« Double click on the chart.
 Format >> Chart type.

+ Select a Chart type and Variant.
» Click OK.

The chart will be converted to the type
selected.

* Double click outside the chart to deselect it.
* File >> Save.

Borders Areal Transparency l Characters | Font Effects | Data Labels

Fill

" Mone (" Hatching
£ olar}  Bitmap

" Cradient

[ ] orange 3 =|
|:| Orange 4

- Bordeaux
[ Pale vellow
|:| Pale green
- Dark violet

[ sun 3
|:|Sun4 —

Ok I Cancel

Help

Reset

Chart Type

Chart category ————————————————
™ 2D

3D

Charttype

=
@

i
RN

ik
A

L

Bars

Variants:

=

=

Motmal

0K

Cancel

Help

i)
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6.4.2

Growth of Visitors to the Centre

L} 1500 3000 4500 G000 Y500 9000 10500 12000 43500 15000 16500 15000

Organisation Charts

6.4.2.1 Create an organisation chart with a labelled hierarchy. (Use a built-
in organisation chart feature)

Impress does not have a built-in feature for creating organisational charts. To create one, you
will need to use OpenOffice.org Draw.

* File >> New >> Drawing.
 Format >> Page. Select the Page tab. Click the Landscape radio button and click OK.

The icons on the Main toolbar that are relevant are shown in the following table.

"[P

Text: Use to insert a text box. A long
click displays a floating text toolbar.

3D objects: Use to insert 3D objects.
A long click displays a floating 3D
objects toolbar.

displays a floating lines toolbar. See
additional note below.

@, [Rectangle: Use to insert a rectangle. ~# |Curves: Use to insert curves. A long
A long click displays a floating click displays a floating curves toolbar.
rectangle toolbar.

gt |Ellipse: Use to insert an ellipse. A long c¢ |Effects: Modifies the orientation,
click displays a floating ellipse toolbar. shape and fill of objects.

_t [Lines: Use to insert lines. A long click nr |Connectors: Use to insert connectors

between objects. A long click displays
a floating connectors toolbar. See note
below.

Lines and arrows: Long-click to open the Lines and Arrows floating toolbar, where
you can add straight lines, lines with arrows, and dimension lines to the current slide.
If you want, you can add an arrow after you draw a line by choosing Format >> Line,
and then selecting an arrow style from the Style box.
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ok Connector: Long-click to open the Connectors floating toolbar, where you can add
connectors to objects in the current slide. A connector is a line that joins objects, and
remains attached when the objects are moved. If you copy an object with a connector,
the connector is also copied.

There are four types of connector lines:
Standard (90-degree angle bends)
Line (two bends)

Straight

Curved

« Click the Rectangle icon on the Main toolbar. This will display a hairline. Click the
position of the top left hand corner of the rectangle, hold down the left mouse button and
drag to the bottom right hand corner. Release the mouse button when you have the correct
size.

+ The handles should still be still be displayed. If not, click on the rectangle to display them.

« Edit >> Copy or Ctri+C.

+ Edit >> Paste or Ctrl+V.

This will paste a copy of the original rectangle on top of the first.

» Click on the top rectangle and drag it to the side of the first.
« Repeat the process till you have a number of rectangles as shown in the following screen.

» Long click on the Connector icon and select the first connector.
+ Create a connection between the top rectangle and the rectangle on the far right of the
second row as shown in the next screen.
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(d 2
i Connectors K

O e N -
g Ry gy mae ey -

ﬁmmmwm%%
— K| |

Using the connector: As useful way of adding connectors is
to create them in a blank area of the diagram and drag them I
to where they need to be inserted.

There are three handles on a connector. The two round ones s
at the end allow you to reposition the end points. The middle
square handle allows you to reposition the central line

without changing the position of the end points. —

Using connectors can be tricky at first and needs practice.

* Now repeat the process until you have the following structure on your screen. Some of the
parts of the diagram are best create by using a number of straight lines.

To create a uniform symmetric organisational chart, use the same method of copying
and pasting for lines and connectors that you used for rectangles. Using the position of
the lines and connectors, you can reposition the rectangles.
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« File >> Save as. Give it a name such as OrgChartl or some other name of your choice.
Draw will add an extension .sxd.

Saving a number of outlines of organisational charts will save you a lot of time if you
need to use them on a regular basis. You could even create a number of templates of
organisational charts.

» Click on each of the rectangles in turn and select Invisible as the Fill color on the Object
bar.

gE| { ﬁiCDntinuDustD.DDcm ;:-_{I-Black :j &ilnvisible ;" j -

* Click on the Text icon on the Main toolbar and drag a text box into each of the rectangles.

« Enter details as shown on the following screen. The font used was 14 pt bold for the title and
14 pt for the name. Centre the text within the text box.

» File >> Save as and give the file the name StaffOrgChart.

Director

Emile Knoar

Admin Head Develbpment Demonstrator Demonsirator
Tames Ndodo Foger Castle Ayivia Mdlowe Herry Sait

Reception Accounts
Sally Lewin FPatricia Bono

* File >> Close.

* Window >> Andromeda.sxi.

* Go to the last slide.

+ Insert >> Slide. Give the name Staff to the slide and use the Title only layout.

+ Enter the words Staff Structure into the Title text box.

+ Insert >> Object >> OLE Object.

* Click Create from file.

» Click the Search button and locate the file StaffOrgChart.sxd that you have just created

and click OK.
« Click and drag the chart so that it is correctly positioned on the screen as shown below.

» Click outside of the chart.
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'4 el 1 2 3 4 3 6 7 & 8 70 11 12 13 14 15 16 W 18 13 20 21 22 23 24 25 28 I7 ZE.QB

Staft Structure

Admin Head Demonsiraior
Tames Mdodn Herwy Sait

* File >> Save.
View the slide show

At this stage, you are probably wondering how the slide show appears.

+ Go to the first slide.
- Press F9.
+ Press Enter to go to the next slide.

Create a chart in Impress

In the description above, you opened Draw and then created an organisational chart. This has
many advantages. You may, however, create the chart in Impress itself as follows:

. Insert a new slide using the Title, Object X
Iayout & Create new £ Create from file

+ Click on the Object icon in the slide. °‘°§i‘:‘§§mwmpmm Cancel

+ Select OpenOffice.org Drawing. Opznotficzora |10 Chart Help

+ Click OK.

Further objects

You may now create a chart in the drawing
area in exactly the same way as you did
using Draw.
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Click to add title
6 7 8 9 10 : 12 13 14 15 16-|17 15 19 @:‘.

Admin Head

T

[@ al el ] [Fi] stide 1 /
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The advantage of this method is that you are able to construct a table more accurately for the
dimensions of the slide.

+ Recreate the Staff slide using this method.

6.4.2.2 Change the hierarchical structure of an organisation chart

Changing the hierarchical structure of an organisational chart involves selecting and dragging
the components of the chart to their new positions. The easiest way of dragging an element is
to click on it and hold down the left mouse button. Then drag the object to its new position and
release the left mouse button.

Group objects

In moving items on a chart, it is useful to be able to group several at once. This will allow you
to work with the set of objects as if it were a single object. This makes repositioning of several
objects that much easier.

In order to create a group, you will need to select all the objects in the group.

* Hold down the Alt key and click each of the items making up the connectors, rectangles
and text boxes of the two demonstrators on the second level. A good way of finding out
the individual elements is to click on part of the structure until you have a clear idea of the
individual elements.

Page 6.77



6.4 OpenOffice.org Impress: Charts, Graphs and Drawn Objects

* Modify >> Group or press the Group icon,

The selected objects will now be treated as a single object.

+ Drag the group to a new position as shown below. Notice that the anchor of the one
connector is still attached to the top level.

_! 1 2 3 4 5 6 7 &8 9 1011 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 28 Eég
Director
Ernilie Krow
ey
Admin Head Development
James Hdodo Rioger Castle
=] = ]
Reception Accounts Deno nsirator Demons trator
Solly Levin Patricia Bono Sytvia Mdlovn Herry Sait
=

« Keeping the previous group selected, Modify >> Ungroup.

+ Select the the text box and rectangle of Development and group them with Modify >>
Group.

» Drag this item so that it is positioned symmetrically under the top level.

« Adjust the positions of the rectangles, text boxes and connectors so that you have a diagram
such as the one shown below. You can make the process simpler by using Modify >>
Group freely.

I 1 2 B 4 g & 7 g 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 28
Director
Ernilie Know
| |
e b
h% h%
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* Click outside the chart.
* File >> Save.

Using the features of Draw to create and modify organisational charts will take practice. Once
you become familiar with the process, it is quite straight forward, but it is important that you
practice it repeatedly until you can work fluently.

6.4.2.3 Add, remove managers, co-workers, subordinates in an organisation
chart

Remove an element

* Go to the Staff slide.

» Double click on the organisational chart.

* Hold down the Alt key and click all the elements comprising the Accounts element.
* Press Del.

* File >> Save.

Add a subordinate
Suppose we wish to add a subordinate for the two Demonstrators.

» Click on any rectangle.

+ Edit >> Copy.

+ Edit >> Paste.

» Drag the copy to midway below the two Demonstrators.

+ Insert a text box inside the rectangle and enter the word Assistant in 14 pt bold. Centre
the text in the rectangle.

* Add connectors as shown in the next screen.

[l 1 2 3 4 5 &7 s 9 10 12 13 14 15 18 17 18 19 20 21 22 23 24 25 26 27 28
Director
Ernilie Krow
Admin Head Development
Jarnes Mdodo Roger Castle

—

Reception Demonstrator Demonsiraior
s-:uye{m Sybi Nl Henry Sait
Assistant
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* Click outside of the chart.
* File >> Save.
6.4.3 Drawn Objects

6.4.3.1 Add different types of drawn object to a slide: line, free drawn line,
arrow, rectangle, square, circle, text box, other available shapes

In the previous section you used rectangles, text boxes, connectors and lines to create an
organisational chart. In this section you will use the other drawing objects.

Open the Andromeda presentation.

Go to the Videos slide.

Insert >> Slide.

Create a Title only slide and call it Thoughts.

Enter the words Develop your thinking in to the Title text box.

Click on the Curves icon on the Main toolbar and draw an irregular object. Insert a text
box inside with the words See. Centre the text in the object.

Long click on the Rectangles icon and selected an Unfilled rounded rectangle. Draw it on
the slide. Put a text box inside with the words Hear.

Long click on the 3D objects icon and select a Cone. Draw the cone in the slide and insert

a text box inside with the words Do.

Click on the Ellipses icon and select an Unfilled oval. Draw it in the slide and add a text
box with the words Learn.

Long click on the Lines and arrows icon. Select the Line with circle / arrow and draw
arrows from each of the objects to the Learn object.

Your diagram should appear something like the one below.

Develop your thinking

Hear

Page 6.80



6.4 OpenOffice.org Impress: Charts, Graphs and Drawn Objects

* File >> Save.

6.4.3.2 Change drawn object background colour, line colour, line weight,

line style
Change line weight (thickness), style and E—"—— FT
colour Line | Line Styles I Arrow Styles I
Line properties ———————  Arrow styles

+ Go to the Thoughts slide. ls_“:;e_ - | T
* Click on the irregular shape. Golar wigth
 Format >> Line or right click and select [ Ligh b 2 | foasem 1 foasem

Line from the context menu. widin Lt LIt
+ Change the Line style to Ultrafine Ti° o 8

dashed . % [~ Synhchronize ends
+ Change the Line color to Light blue.

* Change the Line width to 0.10cm.
* Click OK.
Ok I Cance| | Help | Reset |
Change the background colour or texture EENEEEE——"_— X
of an object ArealShadowI Transparency Colorslcrauients | Hatchinng\tmapsI
Properties
. Marne i‘fellow— Add
* Click on the Oval.
. . Calar | Yellow ot Madif

« Format >> Area or right click and select = _ oary |

Area ] Table: standard - Edit.. |
+ Click the Colors tab. |!=FE=;5E_ — petere. |
» Select a background colour and click OK. EEENT ] g [ o

AN . 2
_ _ . EEEEEEEE < = 3 3|
You could instead have inserted a Gradient, L 111 | [ g [0 3
Hatching or Bitmap as the background by hﬁgp=£|!g Ll
clicking on the appropriate tab. ] DEEE
EEEREET

* File >> Save.

Ok I Cance| Help Reset

6.4.3.3 Change arrow start style, arrow finish style
Change the thickness, style and colour of arrows.

You may use the identical method of the previous section to change the thickness, line style
and colour of arrows.

Page 6.81



6.4 OpenOffice.org Impress: Charts, Graphs and Drawn Objects

Change the arrow style Line
Line | Line Soyles I Arrow Snyles |
+ Select one of the arrows in the Thoughts L‘“ﬁ:’:"”““i “”;j;:“"“
Sllde' I Cantinuous ;I , — = Arrow X
« Format >> Line or right click and select Colar e
Line. | Biack | :q: Double Arrom
. - . Rounded shortarrow
* CI'Ck the Llne tab- Width 4— Symmetric arrtow
ID.DDcm 3: = Line arrow
i el Rounded large arrow
In the two Style spin windows, you may CEEE i
select new styles for the start and end points M hiiorcanca:

of the arrows.

¥

« Select new styles for the ends points of the

arrows.
+ Change the arrow colour. ok | _concel | e | e
+ Click OK.

* File >> Save.

6.4.3.4 Apply a shadow to a drawn object

+ Select the Learn object in the Thoughts s

Sllde Area ShaduIM| Transparency | Calorsl Cradients | Hatching I B\tmapsl

Properties
¥ Use shadow

« Format >> Area and select the Shadow

tab. —_—
+ Tick the Shadow check box. ! 2 —

« Change the default attributes of the

shadow, if you wish.
* CI'Ck OK. Color

Transparency 0% -

Distance 0.30cm ==

QK I Cancel Help Reset

6.4.3.5 Rotate, flip a drawn object
Rotate a graphic using the mouse

+ Go to the Telescope slide.
« Click on the image to select it.

« Click the Rotate icon, G , on the Main toolbar.
« The handles around the graphic change from green to red.
« Click on any of the corner handles and drag the image to rotate it.
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Telescope

, View the heavens through
our powerful
astronomical telescope.

+ Release the mouse button when you have achieved the desired angle.

Rotate an image using the Format menu

* Click on the image.
* Format >> Position and size.
* Click the Rotation tab.

Position and Size |

Position and Size Rntatinnl Slant & Corner Radius I

Pivot point

+ Change the Rotation angle in the spin
window or click on one of the Default

settings.
« Click OK.

Default settings

Position X |m —:] & & 8
Position ¥ |12.57cm ':3 l i tJ“
l—(‘
Rotation angle
Default settings
Angle |360.UD degrees {’i i # i
7 .
oK I Cance| | Help | Reset |

6.4.3.6 Align a drawn object: left, centre, right, top, bottom of a slide

« Click on the image.
- Right click to display the Context menu.
- Select Alignment and then select how you wish the object to be alighed on the slide.

If you wish to change both the horizontal and vertical alignment, you will need to use this

command twice.

Page 6.83




6.4 OpenOffice.org Impress: Charts, Graphs and Drawn Objects

| Andromeda.sxi - OpenDffice.org 1.1.0 Text...
File Edit AMiew |Insert Format Tools SlideShow  indow  Help ,ﬁ?. Pasition and Size...

FEedE ase s ongnse
$ [Derault Tl o H Pl Hdow H oo H A i

F4

B

il

- S8 Character..
|1—|.5 4 3 2z 1 | 1 2 3 4 5 & 7 8 3 1011 £ paragrapti. 021 22 23 24 25 26 27 2|
BE .
Er; Atrrange r|
? i Alighment b [:'l? Left
wf ™ Elip e G Centered
C: " Canvert s lfl:| Right
L
8 + Marme Object... o0 Top
BHe Cernter
p| % Effects
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6.4.3.7 Resize drawn object, chart within the presentation

The method of resizing drawn objects and charts is identical to the method of resizing graphics

described in section 6.3.3.3.

6.4.3.8 Bring an object to the front, back

If parts of two objects occupy the same space on a chart, one will be partly hidden by the
other. The one that you can see is said to be in the front or foreground while the other is at

the back or in the background.

* Go the the Thoughts slide.

« Drag the cone onto the oval. Notice that part of the cone disappears behind the oval.

* Click the oval to select it.

» Right click to display the context menu. Select Arrange then Send to back.

0 Line
g Area.
Text.
"‘é' Pasition and Size.. F4
£ Edit Points F&

Deve] G Character..: :1ng

& Paragraph...

Arrange

LT Bring to Frant

9| 20 21 2z 23 24 25 26 27 2‘

Crrl4Shift++
Ctrl++
Cteld-
Ctrl45hift4-

v
Alignment I3 ] Bring Forward
# Elip e [ SendBackward
See s : =
* : Narne Ohject &1 InFrontof Object
® EBehind Object
% Effects -
é‘* Interaction...
Editsnyle...
& cut Crl+X
Copy ctritC
G paste Ctrlbit
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The oval will be placed behind the cone.

6.4.4 Duplicate, Move, Delete

6.4.4.1 Duplicate a chart/graph, drawn object within the presentation,
between open presentations

The method for duplicating charts and drawing objects is identical to that for duplicating

graphics described in section 6.3.3.1.

6.4.4.2 Move a chart/graph, drawn object within the presentation, between
open presentations

The method for moving charts and drawing objects is identical to that for moving graphics

described in section 6.3.3.2.

6.4.4.3 Delete a chart/graph, drawn object

- Select the chart or object.
+ Press Del.
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6.5 OpenOffice.org Impress: Slide Show Effects

6.5.1 Preset Animation

6.5.1.1 Add preset text, image animation effects to slides. Change preset
animation effects on text, images

Run a slide show

* Open the Andromeda presentation.

* Go to the first slide.

+ Slide show >> Slide show or press F9.

* Press Enter to move to the next slide.
OR click the left mouse button to move to the next slide and the right mouse button to the
previous slide.

» Press Esc at any stage to stop the slide show.

Apart from the change of slides, the slide show is entirely static. Animation and transitions
allow you to have a changing dynamic display.

Add animation to text ' |
Text Text Animation
* Go to the Computers slide. Ul et Iy
» Select the text. e receon | [
« Format >> Text or right click and select ’ 3
Text.
* Click the Animation tab. ’ ;swmm
* Select the Blink Effect. [ Textvisible when exiting
[ C||Ck oK_ Amimationc.vc\es
« Click outside the text box to view the ’79‘ E
effeCt. ¥ Eixels
Delay
Remove the animation 7 Autoratic 3
You can remove the effect by following the S R T

above procedure but selecting No effect.

Change the animation

* Go to the Computers slide.

+ Select the text.

 Format >> Text or right click and select Text.

* Click the Animation tab.

» Select the Scroll in and select a Direction by clicking on one of the direction arrows.
+ Click OK.

+ Click outside the text box to view the effect.

* Try out the different text animations and select one you are happy with.

Add effects

Objects can be faded into a slide, possibly with sound effects, when a slide is displayed. If you
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add effects to an object, it will not be displayed when the slide appears. You will need to click
once mouse on the mouse button to fade it in.

Effects A

* Go to the Telescope slide. IF — | T | il | I—i‘
+ Select the image. o= MHS T £
+ Slide show >> Effects. Effects
* Under Effects select Favourites
« Double click on the Dissolve effect. [Favorites 2
» Set the speed to Medium. - | —— —
+ Close the dialogue. -* | ag|
+ Deselect the graphic. : ' T : ’
* Press F9 to to see the effect. " ' ABC
Notice the slide show will start at the current '
slide. It is only when you click the mouse E:& PN
button that the graphic is displayed. [ = |

i Dissolve
* Press Esc to stop the slide show. .

|

» Select the image once again.
+ Slide show >> Effects. I RE = | [r5 | 15 | I?i‘
« Under Effects select Fade.
« Double click the Fade from Centre effect. il
- Set the Speed to Fast. |Fade |
* Close the dialogue.
« Deselect the image. E:E
* Press F9 to view the result. (=i
» Experiment with the other Effects. [ [ [ l .:IFad.e T T
The Effects can also be applied to text [ [ -
boxes and other objects. o ! E G
+ Apply an effect to the text in the Fade From Center

Telescope slide.

+ Add animations and effects to the slides in the presentation.
* File >> Save.

Animations and effects need to be used with discretion. Correctly used they can add to
the professionalism of a presentation. Over-use makes a presentation look gimmicky.
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6.5.2 Transitions

6.5.2.1 Add transition effects between slides. Change slide transition effects
between slides

A transition is an animation effect that takes place when a new slide is displayed.

Apply a transition to a single slide =
+ Go to the Computers slide. [ oS | [75 | I.&' v I |

+ Slide show >> Slide transition.
+ Select Favorites. Elzects
+ Double click the Dissolve transition. IFa-,_,-,:,ritES j
« Set the speed to Medium.

* Close the dialogue. [ - [ i "

* Go to the first slide. -*

- F9.

Notice the effect of the slide transition when
you get to the Computers slide.

« Try out different transitions on different

slides. ; Dissolve
Dissolve
Medium LI

The comments made about animations and effects also apply to transitions. Use
them with discretion and avoid having too many different transitions in a single
presentation.

Apply a slide transition to a number of slides

* View >> Workspace >> Slides view.

» Select a set of slide by holding down the Shift key and clicking. The same action will also
unselect a previously selected slide.
OR
Press Ctrl+A to select all the slides.

+ Slide show >> Slide transition.

* Double click a transition.

+ Select a Speed.
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LI iMedium j Transition IManuaI j I

Effect |
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Close the Slide transition dialogue.
Go to the start of the presentation.

Press F9 to view the slide show or press
scroll bar.

Slide show settings

You can change the settings for slide shows.

« Slide show >> Side show settings.

This displays the dialogue shown in the
adjacent screen.

== =

Effects

&
Andmmeda .
= S e L ey it Featuies P hotographic Gallery Telescope
= Ihaxctin Bplas Vwite b ns fongh
Diplae ) b e T
Tatyo mind and epiir Flotogaphic sl @
Foax o fha dirtant mlaar Tikicopa ]L‘ "
g A j\ |
idoer and flme P b y
P & LR [ B 3
untific a1 chno ko gical grme g F !
Tl ol Mobgeph Thbmeo
- "
Computers Videos Develop your thinking EHIRAR - B
Up 1o (8 ukleos o the i Slide Transition A
BEstzckitne and -
There are o s aerer i

[z v=

lMedium

on the Main toolbar or H on the Vertical

Rarige
& il slidest

0K

& Erom:
o Cystom Slide Show

|.-“=arinf-

Cancel

El

Help

Custom shiow 1

Al

7|

Type Cptiohs
* Default [~ Change slides manually
© indow ¥ Mouse pointer wisible
i Auto I~ Mouse pointer as pen

00:00:10

I Show logo

I Mavigator visible
¥ Animations allowed
¥ Change slides by clicking on background

[™ Presentation always antop
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6.6 OpenOffice.org Impress: Prepare Outputs

6.6.1 Preparation

6.6.1.1 Select appropriate output format for slide presentation such as:
overhead, handout, 35 mm slides, on-screen show

Set default print options

* Tools >> Options.
» Expand the Presentation option.
* Click Print.

DOptions - Presentation - Print I ﬂ
OpenOffice.org .
Load fSave Contents Quality
Language Settings v Drawing v Liefault
Internet
Text Docurnent [~ Motes " Grayscale
HTML Document
s :
CiviRichee [~ Handouts Black & white
Bl Presentation [~ Outline
Ceneral
View Print Page aptions
Grid
[~ Page narre & Default
Crawing B o
Date Eitto page
Formula - - i
Chart [~ Titne " Tile pages
Data Sources
v Hidden pages & Brochure
¥ Front [ Back
[~ Paper tray from printer settings

0] I Cancel Help Back

« Make the changes. These will become the default print options. Setting the print options is
described below.

+ Click OK.
Select print output print x|
Printer
- - Marme |\\Ws] \HF Laserjet 1200 Series PCL & j Prnpertjes
* File >> Print. o et 4|
R . . atus efault printer
» Select a printer by clicking on the Name T winsposl
drop down window. Loeaon Heo2
- Comment
« Select the Number of copies and whether -
. . Print ta file
you wish the copies Collated.
° H 1 Printrange Copies
If'you wish to print pnly a range of pages, e [ —
click the Pages radlo button. e e Jﬂﬂ Jﬂﬂ =
Enter the range in the form 4-9 for a £ Gelesion ! !
continuous range or in the form 4,5,8 for a
. Diptions... Ok Cancel Hel
selection of pages. Do | | | » |

* Click the Options button.
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Printer Options i x|
Cantents Ciuality
[V Drawing % Default
[~ Motes i~ Crayscale RS
[T Handouts " Black & white Help
[ outline
Print Page options
[~ Page narme ¥ Default
[ Date " Fitto page
I~ Time " Tile pages
[v Hidden pages i Erochure
¥ Front [¥ Baci
[T Papertray from printer settings

The options are the same as for the defaults that were shown earlier.

If multiple options are set, all will be printed.

Drawing

Select this option to print the slides as they appear in the slide show. To view the slides as
they would appear in this view:

* View >> Workspace >> Drawing view.

Notes

Select this option to print slides with notes. To see how the print output will appear:
+ View >> Workspace >> Notes view.

Outline

Select this option to print slides in outline view. This will be in the same form as the display set
with:

+ View >> Workspace >> Outline view.

Page name
Select this option if you wish the page name to be printed on the slide.
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Handouts

Select this option to print the slides as handouts with multiple slides per page. This option is
useful if you wish to give hard copies of the presentation to your audience.

To see what the handouts would look like:
+ View >> Workspace >> Handouts view.

Change the number of handouts per page

Marre

+ Format >> Modify layout. [ andouts
+ Select the desired layout. Select an AutoLayout

IN=REE

Cancel

Help

all

Ll

Six Slides

Erisplay
[¥ Backatourd

[V Obijects an backarourd

Select an output medium when you Aut bl oL BEREE R x
create a presentation =\

i 2 Wyl esc
When you create a slide show with: SR o i
+ File >> New >> Presentation. [ e =
+ Click the Next button. Erie i m—

Subtle Accents

This displays the Autopilot Presentation 2 et o ot e
dialogue in which you can select a number of € origin & Srgen
Output medlums: " Overhead sheer T Slide 7 Bsvien
- Overhead sheet C Paper i
- Paper " |
_ SCl?een Help Cance| << Back | Mext > Create
- Slide

In each case, Impress will create a presentation appropriate for the medium selected.
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6.6.1.2 Spell-check a presentation and make changes such as: correcting
spelling errors, deleting repeated words

Use appropriate language dictionaries

When using spell checking, it is important that you use the correct dictionaries. A common
problem is that only American spellings of words are checked and not the English. The
following section shows how to set up the dictionaries.

+ Tools >> Options.
+ Expand Language settings and select Languages.
+ Make sure that English (UK) and any other language you need is ticked.

Options - Language Settings - Languages B 5[

Opendffice.arg

Load {Save Feialage o
Bl Language Settings Locale setting |Eng|ish (South Africa) ;I
Languages
Writing Aids Default currency IZAR R English (South Africa) j
Internet
Text Document Default languages for dacuments
HTML Document
Spreadshest Western E
Presentation &% English (LK)
Drawing bt i S
Farmula T
English Zimbabwe
Chart CIL Estgonian(Z )
Data Sources Eeiiah

French Belgium)

Asian languages support
[~ Enabled

Cormpley text layout (CTLy support
™ Enabled

Ok I Cancel | Help | Back |

+ Select Writing Aids and make sure that Check in all languages under Options is ticked.

Dptions - Language Settings - Writing Aids 5[

OpenOffice.org

Load {Save Writing aids
- Language Settings Available language modules
Languages 4
u'u'r'irnq . T [ openOffice org MySpell SpellChecker Edit... |
T ¥ ALTLinux LibHnj Hyphenator
I~ QpenOffice.org Thesaurus =

Text Document

HTML Document
User-defined dictionaries

Spreadsheet

Presentation W computer terminology [All] Mews...
Drawing ¥ standard [Al1] =

Formula ¥ saoffice [All] Edit |
Chart % sun [All] —

Data Sources ¥ IgrioresliList [All]

[relete

Ll

_ I
[

Dpt

[ Checkwords with numbers ;I Edit.
v Check capitalization J

Check special regions

Check in all languages

v AutoCheck
e e R e s =

(0] I Cancel | Help | EBack
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» Click OK.
Spelicheck the presentation

AutoSpellcheck will check spelling as you type. Spelling that is not recognised will be
underlined in red. This feature is enabled with:

* Tools >> Spellcheck >> AutoSpellcheck or press F7.

This function is a toggle and will switch the feature on and off. When you execute Tools >>
Spellcheck, check if there is a tick next to AutoSpellcheck. If there is, the feature is already
enabled. In this case, press Esc.

Run spellcheck on entire presentation A
Qriginal FPhotoggraphic lgnore
+ Tools >> Spellcheck >> Check or press s O | _ Awusignoe
F7. Suggestions
Always Replace

The spellcheck will begin checking the spelling
at the current position. When it gets to the

end of the presentation, it will ask you if you Thesaurus.
wish to go to the beginning to check. EE s gl (54) 7| Options
Dictionary |sm’ﬂce A j Add W

When it encounters an error, it displays a
dialogue with Suggestions.

Unknaown word Help | Close |

You can choose a suggestion and click Replace or you can click Ignore if you are sure the
word is correct.

Another alternative is to type the correct spelling into the Word window and click Replace.
Spellcheck a single word or block of text

» Highlight the word or block of text to be checked.
* Proceed in the same way as checking the entire presentation.
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6.6.1.3 Add notes for the presenter to slides

As mentioned in previous sections, notes can % 2 1 Yal 2 3 4,56 7 B 910111213144516171
be added to slides. These notes are not — — —
displayed during the slide show, but can be
printed by checking the Notes option
described earlier. One of their purposes is to

provide notes for the presenter. These could Telescope
include details not included in the slide itself P
or points that need emphasising. _ o powertl
adtT ottt ol telesc ope,
* Open the Andromeda slide show. %ﬁﬁ;ﬁ
* View >> Workspace >> Notes view. \} 1
£ pi

An additional text box is created below the

slide for adding notes.
?’//_//////////////(///////////////,EV///////////////////////////////

glee atechnical description of the telescope:
* Enter some notes. Z
o : : ?8 Mewtonian reflactor
Click outside of the notes text box. 59 99% reflectivity of mitre

* File >> Save. imuthal mounting with precidon settings

s

The presenter would print the slide show with
notes and use these while presenting the slide
show.

B ] A

AN I SR

e

o
s |

6.6.1.4 Change slide setup, slide orientation to portrait, landscape. Change
paper size.

The normal orientation of a slide show in =
landscape. This follows from the fact that  Pee|sscaround |

computer screens are wider than they are  eerfrme—
Eorma A ot
deep. You may, however, change the y ' >
orientation and change the paper size. L -
Height !2970cm -CE{
rientation (% Porora
- Format >> Page. premen T Sme oo e 3]
Landscape Paper tray [From printer settings] =

Margins —————————————— Layout settings

The default setting for the Format is Screen Lere o0 =4
and for the Orientation is Landscape. e e SRR i

Top 1.00cm = [¥ Eitabject ta paper farmat

The adjacent dialogue shows the Format o P

changed to A4 and the Orientation to
Portrait.

oK I Cancel Help Reset
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If the Fit object to paper format box is checked, the ratio of the width to length of the object
will changed according to the dimensions of the new Format.

» Click OK.
* Press F9 to view the slide show in the new orientation.

6.6.1.5 Duplicate, move slides within the presentation, between open
presentations

Change the order of the slides

+ View >> Workspace >> Slides view.
+ Select the Ratios slide.
» Hold down the left mouse button and drag the slide to the Thoughts slide.

The slide will be inserted after the slide you drag it onto.

‘? You may select more than one slide by holding down the Alt key.

Move slides using the Edit menu
You could have used the Edit menu to achieve the same result as follows:

* View >> Workspace >> Slides view.
» Click on the Photographs slide.

« Edit >> Cut or Ctri+X.

« Click on the Entrance fees slide.

« Edit >> Paste or Ctrl+V.

Copy a slide between presentations
The above method can be used for moving slides between presentations.

* Open the presentation you are copying from.

+ View >> Workspace >> Slides view.

» Select the slide you wish to copy, or multiple slides by holding down the Alt key and clicking
on the slides.

« Edit >> Cut or Ctrl+X.

* Open the presentation you wish to move to.

+ View >> Workspace >> Slides view.

* Click on the slide before the insertion point.

+ Edit >> Paste or Ctri+V.

Copy a slide within a presentation using the mouse

Copying a slide using the mouse is very similar to moving a slide using the mouse, except that
the Ctrl key is pressed while dragging.

* View >> Workspace >> Slides view.
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Click on the first slide and hold down the left mouse button.

Now press the Ctrl key and drag the slide to the last slide. The mouse pointer should display
a+.

Release the left mouse button.

A copy of the slide can be made in another presentation using this method.

Copy a slide within a presentation using the Edit menu

View >> Workspace >> Slides view.
Click on the Photographs slide.

Edit >> Copy or Ctri+C.

Click on the Entrance fees slide.

Edit >> Paste or Ctri+V.

Copy a slide between presentations

The above method is a convenient one for copying between presentations.

Open the presentation you are copying from.

View >> Workspace >> Slides view.

Select the slide you wish to copy, or multiple slides by holding down the Alt key and clicking
on the slides.

Edit >> Copy or Ctri+C.

Open the presentation you wish to copy to.

View >> Workspace >> Slides view.

Click on the slide before the insertion point.

Edit >> Paste or Ctri+V.

6.6.1.6 Delete a slide, slides

Delete a slide in Slides view OpenDffice.org 1.1.0 x|

+ View >> Workspace >> Slides view. |® This action deletes the selected page,
« Click on the slide to be deleted.
* Press Del and confirm that you wish to delete

Delete a slide in Drawing view

Mote: the page contains drawing objects!

the slide. Tes | Ho;

View >> Workspace >> Drawing view.
Select the slide to be deleted. G Modify Slide...
Right click on the slide tab. Eename Slide...
Click Delete slide.

Confirm that you wish to delete the slide.

R Paste CHrl Y
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6.6.2 Printing

6.6.2.1 Print entire presentation, specific slides, handouts, notes pages,
outline view of slides, number of copies of a presentation

Print a hard copy of a presentation

The setting of the Options and the various types of output was covered in section 6.6.1.1.

* File >> Print. Pent x|
+ Click the Options button and set the . _—
options as described in section 6.6.1.1 e p—l
+ Select a printer from the Printer drop down Tyne Acrabat Distiller
window. L
» Click All to print the entire presentation or I
click Pages and enter the pages you wish )
tO pl’lnt. P"i:__t'z:ge CDI:Le;beroch ies =
+ Set the Number of copies and tick Collate = ¢ ru. TR N ; ) ;C o
if you want the pages to be collated. 2 gl Jiu Jiu '
¢ C“Ck OK' Options... OK. I Cancel | Help I

Print to a file
There are occasions it is useful to send the print output to a file rather than a printer.

+ In the Print dialogue, tick the Print to file checkbox.
« Enter the name of the path and file to store the print output when prompted. This will create
a file with a .prn extension.

6.6.3 Deliver a Presentation

6.6.3.1 Hide, show slides
Custom slide shows

One way of hiding certain slides is to create a custom slide show which includes only
selected slides. This is covered in the next section.

Hide slides

When you hide a slide, it will still be visible in all the modes. However, when you run the slide
show, the slide will not be displayed. Y

+ Open the Andromeda presentation.
+ View >> Workspace >> Slides view.
+ Select the Visitors slide.

+ Slide show >> Show/Hide slide or press the v icon.
» Select the Staff slide and repeat the process.
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When a slide is hidden, its name appears greyed out.

» Go to the first slide, press F9 and scroll through the slides.
Show slides

The Show/Hide function is a toggle.

» Select the Visitors slide.
+ Slide show >> Show/Hide slide.
» Use the same process to unhide the Staff slide.

6.6.3.2 Start a slide show, start a slide show on any slide
Start a slide show from Drawing view.

* Make the slide you wish to start from the current slide.

=]
» Slide show >> Slide show or press F9 or press = on the Main toolbar or H on the
Vertical scroll bar.

Start a slide show in Outline mode

* Click the slide you wish to start from.

=]
+ Slide show >> Slide show or press F9or press ® on the Main toolbar or H on the
Vertical scroll bar.

Create a custom slide show

A custom slide show comprises a selection of x|
slides. Hame | Exhbitis] aK |
. . Existing slides Selected slides Cancel |
+ Slide show >> Custom slide show. Title z Telestope
H Features Photographs Hel
¢ Click New. Photographs videos él

+ Select the slides you wish to include in the
order in which you wish them to appear in
the custom slide show.

¢ Give the custom slide show a name.

* Click OK.
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Run a custom slide show

+ Slide show >> Custom slide show.
* Tick the Use Custom Slide Show

checkbox.
» Highlight the slide show you wish to run.

* Click Start.

¢ Untick the Use Custom Slide Show when
you have finished otherwise F9 will start
the Custom slide show.

Custom Slide Shows ]

[¥ Use Custorn Slide Show

Edit...

Delete
Copy
Help
Start

LClose

I
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